Oracle Talent Management Cloud
Using Goal Management
# Contents

## Preface

1. **Worker Goal Assignment**  
   - Goal Management: Explained  
   - Establish Worker Goals: Overview  
   - Making Performance Goals Available to Workers: Points to Consider  
   - FAQs for Establish Worker Goals

2. **Talent Profiles**  
   - Managing Talent Profiles: Overview  
   - Talent Profile Summary: Explained  
   - Compare Profiles and Find the Best Fit  
   - FAQs for Compare Profiles and Find the Best Fit  
   - Creating and Updating Profiles  
   - FAQs for Creating and Updating Profiles  
   - Modifying Talent Profiles

3. **Goal Management**  
   - Manage Performance Goals: Overview  
   - Managing Your Goals  
   - Administer Goals  
   - Performance Goal Measurements: Explained  
   - Goal Actions  
   - Mass Approve Goals  
   - FAQs for Goal Management

4. **Review Periods**  
   - Review Periods in Talent Management: Explained
5 Organization Goals
Assigning Organization Goals: Explained 61
Managing Organization Goals: Explained 62
Cascading Performance Goals to Promote Strategic Alignment Throughout an Organization: Example 64
FAQs for Organization Goals 68

6 Spreadsheets for Uploading Goals
Uploading Worker Goals, Measurements, and Tasks Using a Spreadsheet: Explained 69
Using the Update Worker Goals Worksheet 71
Using the Goals Update Measurements Worksheet 72
Using the Goals Update Tasks Worksheet 73
Uploading and Assigning Organization Goals Using a Spreadsheet: Explained 74
Using the Organization Goal Assignment Worksheet 75
Using the Organization Goals Upload Worksheet 76
FAQs for Spreadsheets for Uploading Goals 76

7 Mass Assignment of Goals
Mass Assignment of Performance Goals: Explained 79
Creating a Request for Mass Assignment of Performance Goals: Points to Consider 80

8 Goal Library
Goal Library: Explained 83

9 Goal Plans
Goal Plans: Explained 85
Worker Goal Plans: Explained 85
Organization Goal Plans: Explained 86
Creating Goal Plans: Points to Consider 87
Goal Plans: Examples 89
Adding Goals to a Goal Plan: Explained 90
FAQs for Goal Plans 92
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>Goal Plan Sets</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Goal Plan Sets: Explained</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Creating Goal Plan Sets: Points to Consider</td>
<td>95</td>
</tr>
<tr>
<td></td>
<td>Changing the Weight of a Goal Plan in a Goal Plan Set: Procedure</td>
<td>97</td>
</tr>
<tr>
<td></td>
<td>Deciding Effective Dates of Goal Plan Sets: Explained</td>
<td>98</td>
</tr>
<tr>
<td></td>
<td>Changing Effective Dates of Goal Plan Sets: Examples</td>
<td>99</td>
</tr>
<tr>
<td></td>
<td>Resolving Conflict in Dates for Goal Plan Sets Due to Transfer: Explained</td>
<td>100</td>
</tr>
<tr>
<td>11</td>
<td>Matrix Management</td>
<td>101</td>
</tr>
<tr>
<td></td>
<td>Using Matrix Management with Performance Goals: Explained</td>
<td>101</td>
</tr>
<tr>
<td>12</td>
<td>Scheduled Processes for Assigning Goals</td>
<td>103</td>
</tr>
<tr>
<td></td>
<td>Managing Scheduled Processes for Assigning Performance Goals: Procedure</td>
<td>103</td>
</tr>
<tr>
<td></td>
<td>Scheduled Processes in Goal Management: Overview</td>
<td>103</td>
</tr>
<tr>
<td>13</td>
<td>Eligibility Profiles for Assigning Goals</td>
<td>107</td>
</tr>
<tr>
<td></td>
<td>Using Eligibility Profiles for Performance Goals Assignment: Explained</td>
<td>107</td>
</tr>
<tr>
<td></td>
<td>FAQs for Eligibility Profiles for Assigning Goals</td>
<td>108</td>
</tr>
<tr>
<td>14</td>
<td>Goal Integrations</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Goal Management: How It Works with Profiles</td>
<td>109</td>
</tr>
<tr>
<td></td>
<td>Performance Documents: How They Work with Goals</td>
<td>111</td>
</tr>
<tr>
<td></td>
<td>Social Networking with Performance Goals: Explained</td>
<td>115</td>
</tr>
</tbody>
</table>
Preface

This preface introduces information sources that can help you use the application.

Using Oracle Applications

Using Applications Help

Use help icons 🎧 to access help in the application. If you don’t see any help icons on your page, click your user image or name in the global header and select Show Help Icons. Not all pages have help icons. You can also access Oracle Applications Help.

Watch: This video tutorial shows you how to find help and use help features.

You can also read Using Applications Help.

Additional Resources

- **Community**: Use Oracle Cloud Customer Connect to get information from experts at Oracle, the partner community, and other users.
- **Guides and Videos**: Go to the Oracle Help Center to find guides and videos.
- **Training**: Take courses on Oracle Cloud from Oracle University.

Conventions

The following table explains the text conventions used in this guide.

<table>
<thead>
<tr>
<th>Convention</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>boldface</strong></td>
<td>Boldface type indicates user interface elements, navigation paths, or values you enter or select.</td>
</tr>
<tr>
<td><strong>monospace</strong></td>
<td>Monospace type indicates file, folder, and directory names, code examples, commands, and URLs.</td>
</tr>
<tr>
<td>&gt;</td>
<td>Greater than symbol separates elements in a navigation path.</td>
</tr>
</tbody>
</table>

Documentation Accessibility

For information about Oracle’s commitment to accessibility, visit the Oracle Accessibility Program website.

Videos included in this guide are provided as a media alternative for text-based help topics also available in this guide.
Contacting Oracle

Access to Oracle Support
Oracle customers that have purchased support have access to electronic support through My Oracle Support. For information, visit My Oracle Support or visit Accessible Oracle Support if you are hearing impaired.

Comments and Suggestions
Please give us feedback about Oracle Applications Help and guides! You can send an e-mail to: oracle_fusion_applications_help_ww_grp@oracle.com.
1 Worker Goal Assignment

Goal Management: Explained

The Goals work area enables workers, managers, and organization owners to define and set goals that support the common objectives of an organization. Workers can update goals throughout a goal setting and tracking cycle, and managers and organization owners can track the goals as workers progress through them.

The Goals work area supports:

- Specific, measurable, achievable, relevant, and time-based (SMART) goals
- Goal plans
- Goal plan sets
- Review periods

>Note: Availability of these features of goal management depends on application settings defined by your organization.

SMART Goals

Use performance goals that are specific, measurable, achievable, relevant, and time-based (SMART) to measure the performance of workers, help them improve productivity, and achieve career objectives. Performance goals are results-oriented, measure work-related performance, and often use specific targets to assess the level of workers’ achievement. For example, the performance goals can specify how workers measure achievement of objectives and include target dates.

Use performance goals in performance documents as part of the evaluation process. Workers and managers can create performance goals. HR specialists can create organization goals. Organization goals are performance goals that you create, or those from the goal library, to set the business direction and targets for your organization. Managers who are also organization owners can add existing performance goals as organization goals. They can then assign them to any level of the manager assignment hierarchy to support the organization’s overall business objectives. Workers’ can align their own goals to the organization goals to achieve the same objective.

Depending on your application settings, your role, and security privileges, you can add tasks and target outcomes to your goal. Tasks are specific actions you add to a goal that a worker undertakes to achieve the goal. Goal tasks have various types, including mentoring, researching, and coaching. Target outcomes enable the linking of a goal to specific skills or qualifications such as competencies, languages, and licenses and certifications. Use target outcomes to increase a worker’s proficiency for current or future job requirements, or to add to the worker’s set of skills.

Workers can mark the performance goals that they create and not linked to any performance documents as private. Private performance goals aren’t visible to others, including managers.

Goal Plans

Goal plans are used to manage a collection of performance goals for a specific period. You can roll out goal plans to individuals, a selected hierarchy, or a wider population within the organization. You can add goals for a worker only when the worker is assigned goal plans. You must associate each goal with a goal plan. Therefore, to add goals to a worker, you must ensure that goal plans are already assigned to the worker. You can associate a worker goal only with one goal plan at a time. Each goal plan is associated with a review period.
Goal Plan Sets
Goal plan sets are used to group and assign performance goal plans to a population set. Each goal plan set is associated with a review period.

Review Periods
Review periods enable you to organize your processes around goal management and performance evaluations into time-bound business cycles. Review period is a common component that ties to goal plans and performance document periods. For example, you create review periods to associate with goal plans and performance documents that fall within the same time frame.

Related Topics
• Performance Documents: How They Work with Goals
• Goal Management: How It Works with Profiles
• Goal Plans: Explained
• Goal Plan Sets: Explained

Establish Worker Goals: Overview
In the Establish Worker Goals activity, you can manage performance goals for your direct and dotted-line reports and assign goals to workers.
To establish worker goals as a manager, start from the My Team Goals page in the Goals work area. The access to this page is dependent on your role and security privileges.
You can also manage goals for a worker from the Goals tab in the worker’s person spotlight, if available to your role. You can access the worker’s person spotlight by clicking the worker’s name in the following locations:
• Directory search results page
• My Team page
• Team Talent page
• Team Compensation page
• Person smart navigation window
Depending on your role and security privileges, you can establish worker goals using the goal plans, the mass assignment request, and data loaders.
As a manager, you can:
• Assign a performance goal to your report’s goal plan within a review period.
• Add target outcomes, if enabled, to goals and automatically update the person profiles of your reports.
• Add and update tasks to provide specific actions that determine how your reports can achieve their goals.
• Align the goals of your reports to other goals.
• Approve goals submitted by direct reports.
• Cancel or delete goals for your reports.
• Copy a goal for a report and change the goal plan and attributes of the new copied goal as appropriate. The copied goal is added to the report’s goals list.
• Move a goal to another goal plan. The moved goal is no longer associated with the source goal plan.
• Extend a goal to another goal plan to let the worker continue working on the goal for a period later than the current goal plan. The target goal plan must have an end date later than the end date of the current goal plan. After extending, the goal is associated with both the source and target goal plans. Any subsequent changes to the goal in the source goal plan are also carried onto the target goal plan after you extend the goal.
• Track measurements added to goals for your reports.

Related Topics
• Person Spotlight: Explained

Making Performance Goals Available to Workers: Points to Consider

HR specialists and managers, if allowed, can assign goals to workers so that they can adapt the assigned goals to their particular needs, dependent on approval. This topic focuses on different methods you use to make goals available to workers in the Goals work area.

Managers can make goals available to workers by:
• Assigning goals to the workers from the worker’s person spotlight, and the My Team Goals and My Goals pages in the Goals work area.
• Publishing goals to the entire organization from the My Organization Goals page in the Goals work area.
• Sharing goals with workers and colleagues from the My Goals page in the Goals work area.

HR specialists can establish worker goals using goal plans, the mass assignment request, and data loaders.

Managers, Organization Owners, and HR Specialists Assign Goals to Workers

The following table describes methods that different roles use to assign goals to workers.

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Managers</td>
<td>Managers can assign their own goals, add new ones, or use existing goals from the goal library. They can assign goals to all their direct reports or a specific direct report. When managers assign their own goals to workers, the workers’ goals are aligned automatically to the manager’s goal. Managers can cascade goals using goal assignment. The line managers can in turn assign the goals to their direct reports. They can assign the goals exactly as they are, or change them to fit the population to which they are assigning the goals.</td>
</tr>
<tr>
<td>Organization owners</td>
<td>As organization owners, managers can also assign organization goals as performance goals to workers. They can add new organization goals, or use existing organization or library goals to assign directly to any level of the supervisory hierarchy. Organization goals that you assign to workers are aligned automatically to the original organization goal.</td>
</tr>
</tbody>
</table>
### Role Description

<table>
<thead>
<tr>
<th>Role</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR specialists</td>
<td>HR specialists can assign goals to workers by creating a goal plan associated with a review period for a specific population and adding goals to the plan. The HR specialist can add goals directly to the plan either before or after creating it. Depending upon the goal plan settings, HR specialists can add additional goals to the plan. They can also use mass assignment requests, application-generated spreadsheets, and other tools such as data loaders to assign goals to workers.</td>
</tr>
</tbody>
</table>

**Organization Owners Publish Goals to the Entire Organization**

Organization owners can publish goals to make them available for workers in the supervisor hierarchy to add to their list of goals. Workers and managers can also align individual worker goals to published organization goals. When workers add an organization goal to their own goals, that goal is automatically aligned to the published organization goal.

**Managers and Workers Share Goals**

Managers can share goals with their direct and indirect reports as an alternative to assigning goals. For example, a manager might want a worker to know about the goals but would like the worker to decide whether or not to add the goals. Workers can share goals with their colleagues. Workers can also align their goals to the shared goals of either a manager or a colleague. A goal that a worker adds from shared goals is automatically aligned to the shared original goal.

**Related Topics**

- Sharing Performance Goals: Explained
- Aligning Performance Goals: Explained
- Person Spotlight: Explained

**FAQs for Establish Worker Goals**

**Why do my direct reports have performance goals assigned to them before I have added or assigned any?**

Performance goals may have been assigned by the organization owner or HR specialist before you assigned any goals. Goals might also be present because the workers created the goals themselves, or copied the goals from shared or organization goals. The HR specialist can assign goals when creating or editing a goal plan.

**What happens if I add a goal to my own goals from the organization or shared performance goals?**

Performance goals that you add from the organization, your manager, or a colleague’s, goals are automatically aligned to the added goal. If the goal creator configures the goal to allow updates, you can edit some attributes of the goal to make it fit your situation. You can select the start and end dates for the goal.
Related Topics

- What happens if I align a performance goal?

What's a key performance goal field?

Configure a key goal field for performance goals to require manager approval when edited.

The key performance goal fields are:

- Goal Name
- Description
- Success Criteria
- Start Date
- Target Completion Date
- Priority
- Category
- Weight
- Measurement Name
- Unit of Measure
- Target Type
- Target Value
- Private

Can I copy performance goals that are pending approval?

No, you can't copy performance goals that are pending approval. Goals that are pending approval are read-only until they're approved.

What happens if I assign my performance goal to a worker?

A copy of the performance goal is added to the worker's list of goals and is associated with the worker goal plan. Your own goal remains in your list and isn't changed. Workers can begin working on the assigned goal, and if you select the option to allow workers to update the goal, they can edit key fields, such as goal name, as needed. You assign a goal from the My Goals page in the Goals work area.
Chapter 2
Talent Profiles

Managing Talent Profiles: Overview

Managers and HR specialists can maintain information within person profiles about the skills, qualifications, accomplishments, and career preferences of their workers. They can also maintain information in model profiles about the targeted skills and qualifications of the jobs and positions within the company. Workers can manage their own careers by keeping their talent profiles current so that their skills, qualifications, accomplishments, and career preferences reflect their current performance and future career goals.

You manage a worker’s talent profile on the worker’s person spotlight. Depending on your role, to open a worker’s person spotlight:

- Select Directory > Directory, search for the worker, and click the worker’s name in the search results
- Select My Team > My Team and click the worker’s name on the My Team page
- Select My Team > Team Talent and click the worker’s name on the Team Talent page
- Select My Team > Team Compensation and click the worker’s name on the Team Compensation page
- Open the person smart navigation window from application pages

This table lists the talent profile-related pages in person spotlight and their key features available to managers, HR specialists, and workers. Workers can open each page from the Me work area in the Navigator.

<table>
<thead>
<tr>
<th>Pages</th>
<th>Features for Managers and HR Specialists</th>
<th>Features for Workers</th>
</tr>
</thead>
</table>
| Skills and Qualifications | - Use the competency gaps chart to compare the competencies of a worker to that of a job from the worker’s interest list, to identify if the worker is a suitable candidate for the job or needs further training.  
- Review areas of expertise and other qualifications for workers. | - Use the competency gaps chart to compare their competencies to that of a job from their interest list, to identify whether they are suitable for a job or to identify training needs.  
- Identify areas of expertise, such as a specific software package.  
- Maintain competencies, degrees, and other accomplishments. |
| Career Planning         | - Add jobs or positions to the interest lists of their workers.  
- Review career preference information for workers, such as job or job family of their next career move.  
- Review and edit talent ratings such as performance and potential of workers, and the risk and impact of losing them. | - Add jobs or positions to their interest lists.  
- View the suggestions list and determine whether to add any of the suggested jobs or positions to their interest list.  
- Identify career preferences such as the job or job family of their next career move. |

Managing talent-profile information in job and position profiles includes both creating the job and position profiles based on profile types, and editing the profiles when business requirements change. Job and position profiles identify the required skills, degrees, qualifications, and work requirements for each job and position within your enterprise.
**Note:** If you’re an existing customer and have Oracle Recruiting Cloud or Oracle Learning Cloud, you must enable the enhanced Talent Profile feature. For more information, see the documents in this article: Controlled Availability -- Upgrading Oracle Fusion Profile Management (Doc ID 2421964.1) on My Oracle Support at https://support.oracle.com.

**Talent Profile Summary: Explained**

The Talent Profile report provides talent-related information for a worker. This topic describes options that you can select when printing the report. To print the report, select the Manage Talent Profile task in the Person Management work area. On the Edit Profile page, select **Actions - Print Profile**. Talent review meeting participants can also print the report for one or more workers from the Talent Review dashboard.

**Report Sections**

The Talent Profile report can contain a person summary and five configurable sections. This table describes the contents of each section.

<table>
<thead>
<tr>
<th>Report Section</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Experience</td>
<td>Current and previous assignments.</td>
</tr>
<tr>
<td>Talent Overview</td>
<td>Performance evaluation information for up three years. The section includes the evaluation period, overall rating, overall comments, and a bar graph comparing the performance ratings. You can also include talent ratings.</td>
</tr>
<tr>
<td>Education and Qualifications</td>
<td>Competency ratings and evaluation types, degrees, licenses and certifications, honors and awards, and memberships.</td>
</tr>
<tr>
<td>Career Options and Interests</td>
<td>Career preference and advancement readiness information, including willingness to travel, relocate, consider part-time employment, or adopt flexible work schedules. You can also include preferred career moves and any jobs in a worker’s interest list.</td>
</tr>
<tr>
<td>Goals</td>
<td>Development and performance goal information, such as goal names, completion dates, statuses, and descriptions. This section includes a graph of goal achievements for the worker.</td>
</tr>
</tbody>
</table>

**Print Formats**

You can print the Talent Profile Summary in the following formats:

<table>
<thead>
<tr>
<th>Print Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PDF</td>
<td>Includes a photograph of the worker and all selected graphs.</td>
</tr>
<tr>
<td>RTF</td>
<td>Includes a photograph of the worker and all selected graphs.</td>
</tr>
<tr>
<td>Print Format</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Microsoft Excel</td>
<td>Includes all selected workers in an Excel workbook, with one profile per worksheet and the worker’s name as the tab label. This format doesn't include the photograph, performance history, or goals graphs.</td>
</tr>
<tr>
<td>HTML</td>
<td>Includes selected graphs but doesn't include the photograph.</td>
</tr>
</tbody>
</table>

**Compare Profiles and Find the Best Fit**

**Comparing Items: Explained**

Use comparison to quickly identify and evaluate differences between items. Compare any person, job, and position items. For example, you can compare a person with another person or with a job profile. You can compare items in the Profiles work area and on the talent review dashboard.

**Selecting Items**

The first item you select is the comparison base, and the items you select subsequently are secondary items. You can change the comparison base if required. The comparison displays the base item attributes, and indicates the differences between the attributes of the secondary items and the base items.

**Controlling Results**

Data sets control which attributes are displayed for each item in the comparison. For example, you must select the School Education data set to display and compare a person’s education details.

The information displayed in the comparison results is controlled by security access. For example, line managers can compare their direct reports and view their performance data in the comparison results. HR specialists can perform this comparison only if they have security access to the persons’ performance information. You can change the effective date of comparison if you are either a line manager or an HR specialist.

**Performance Information in Comparison Results: Explained**

The comparison displays the performance data of only those persons who are evaluated using the enterprise-wide designated rating model, because you can’t compare persons who are evaluated using different rating models.

For each person, the comparison displays up to three performance documents. These performance documents include the latest document using the designated rating model plus the two most recent previous documents that use the same performance template as the latest document. However, the performance documents and performance periods for the persons being compared may be different. The comparison indicates the performance attributes’ differences only if the performance documents are the same for the persons being compared.
Best-Fit Analysis: Explained

The best-fit analysis includes the review of all profiles of the match type required and calculation of the overall score compared to the source profile. The overall score appears in the Overall Fit column in the results section on the Find Best Fit page. Employees, managers, and HR specialists can use the Best-Fit feature to match and compare profiles with the selected match criteria. The Best-Fit feature finds profiles that closely match the source profile (person or job). You can associate both jobs and positions with the job profile type. Therefore, in a best-fit analysis, a job profile can be either a job or position.

Best-Fit Analyses Types

The application supports the following four types of best-fit analyses:

- **Person to Job**: Using a person profile as the source profile, you can find the job that best fits a worker.
  
  Example: As a manager, use this tool to help a worker to identify job profiles for which the worker is best suited and decide the next career move.

- **Person to Person**: Using a person profile as the source profile, you can find the worker with skills that match that of a particular worker.
  
  Example: Your company is planning to launch new technology. As an HR specialist, you know a worker who has the required skill to use the new technology. To assess the scope of workers who need development in this particular skill, you can select the worker’s profile. You can then use the Best-Fit feature to view a list of other workers who may come close to the skill requirements.

- **Job to Job**: Using a job profile as the source profile, you can find the job profile that closely matches a job profile.
  
  Example: As an HR specialist, you can use this tool to help locate jobs to identify areas for outplacement, training requirements, or areas of organizational strength.

- **Job to Person**: Using a job profile as the source profile, you can find the best-fit worker for a job.
  
  Example: As an HR specialist, you can use this tool to help locate the most qualified workers for a job opening within your company.

The Best-Fit Feature Accessibility

The roles, privileges, and application settings determine the ability for a user to perform a type of best-fit analysis. The following table shows the Best-Fit feature accessibility for the most commonly used profile types.

<table>
<thead>
<tr>
<th>Role</th>
<th>Can Perform Person to Job Analysis?</th>
<th>Can Perform Person to Person Analysis?</th>
<th>Can Perform Job to Job Analysis?</th>
<th>Can Perform Job to Person Analysis?</th>
</tr>
</thead>
<tbody>
<tr>
<td>HR specialist</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Manager</td>
<td>Yes (Limited to direct and dotted-line reports)</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Worker</td>
<td>Yes</td>
<td>Yes (Limited to worker’s own profile)</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Filtering Best-Fit Results
By default, the best-fit analysis results show all profiles that have 90% match or greater than the selected source profile. You can further filter the results to show by overall fit or by number of profiles. The results section of the best-fit analysis also has the Show Fit by Criteria option. Use this option to view which content types displayed in results meet or exceed the specified criteria percentage.

Accessing the Best-Fit Feature as an HR Specialist: Procedure
Depending on the privileges associated with the HR specialist role, an HR specialist can find:
- The best-fit job or person for a person profile.
- The best-fit job or person for a job profile.

Finding the Best-fit Job or Person for a Person
HR specialists can find the best-fit job or person for a person by using one of the following navigation paths:

- From the Person Profiles page:
  a. Select Navigator > My Client Groups > Profiles.
  b. Click the Person Profiles tab, if not already selected, and search for the person profile.
  c. Select the profile in the Results section.
  d. From the Actions menu, click the corresponding link to find the best-fit job or person for the selected profile.
- From the Skills and Qualifications page:
  a. Select Navigator > My Client Groups > Profiles.
  b. Click the Person Profiles tab, if not already selected, and search for the person profile.
  c. Click the profile in the Results section to open the Skills and Qualifications page.
  d. In the Related Links panel, click the corresponding link to find the best-fit job or person for the selected profile.
- From the person smart navigation window:
  a. Click the More icon for a person on application pages to open the person smart navigation window.
  b. Select Talent Management and click the corresponding link to find the best-fit job or person for your report.

Finding the Best-fit Job or Person for a Job Profile
HR specialists can find the best-fit job or person for a job profile by using the Model Profiles page. This page includes all jobs and positions profiles associated with the job profile type.

To find the best-fit job or person for a job profile:

- From the Profiles page:
  a. Select My Client Groups > Profiles.
  b. Click the Model Profiles tab, search for the job name.
  c. Select the profile in the Results section.
  d. From the Actions menu, click the corresponding link to find the best-fit job or person for the selected profile.
- From the Select Candidates page when creating or editing a succession plan:
  a. Select Navigator > My Client Groups > Succession Plans.
b. Click the Succession Plans tab, if not already selected.
c. Click Create to create a plan, or select an existing plan and click Edit from the tab toolbar.
d. Enter or edit the necessary details and click Next to open the Select Candidates page for the succession plan.
e. On the page toolbar, click Find Best Fit to find the best fit person for a model profile and add the person as a candidate.

- From the Select Members page when creating or editing a talent pool:
  a. Select Navigator > My Client Groups > Succession Plans.
  b. Click the Talent Pools tab.
  c. Click Create to create a talent pool, or select an existing pool and click Edit from the tab toolbar.
  d. Enter or edit the necessary details and click Next to open the Select Members page for the succession plan.
  e. On the page toolbar, click Find Best Fit to find the best fit person for a job profile and add the person as a member.

Accessing the Best-Fit Feature as a Manager: Procedure

Depending on the privileges assigned to the manager role, managers can find the best-fit job or person for a person.

Finding the Best-fit Job or Person for a Person

Managers can find the best-fit job or person for a person by using one of the following navigation paths:

- From the Team Talent page:
  a. Select Navigator > My Team > Team Talent.
  b. Click the link to a report. The Skills and Qualifications page of the report opens.
  c. In the Related Links panel, click the corresponding link to find the best-fit job or person for your report.

- From the My Team page:
  a. Select Navigator > My Team > My Team.
  b. Click the link to a report. The Employment Information page of the report opens.
  c. Select Actions > Talent Management and then select the corresponding link to find the best-fit job or person for the selected profile.

- From the person smart navigation window:
  a. Click the More icon for a report on application pages to open the person smart navigation window.
  b. Select Talent Management and click the corresponding link to find the best-fit job or person for your report.

Accessing the Best-Fit Feature as a Worker: Procedure

Depending on the privileges assigned to the employee role, workers can:

- Find the best-fit job profile for their person profile.
- Add the job profile to their careers of interest list.
Finding the Best-fit Job

Workers can use one of the following navigation paths to access the best-fit job feature:

- From the Skills and Qualifications page:
  
  a. Select **Navigator > Me > Skills and Qualifications**.
  
  b. In the Related Links panel, click **Find Best Fit Job**.

- From the person smart navigation window:
  
  a. Click the More icon for your name on application pages to open the person smart navigation window.
  
  b. Select Talent Management and click **Find Best Fit Job**.

By default, the Find Best Fit Job page displays results for jobs with an overall fit greater than or equal to 90% criteria. You can modify the criteria to find the best-fit job for your role.

Best Fit: How It's Calculated

The Best-Fit feature compares the selected profile content with that of target profiles to find a list of profiles that are the closest match. You find the best fit job or person using the best-fit feature accessible from application pages.

Example: As an HR specialist, you can use the Best-Fit feature to find the person best suited for a job. The initial best-fit analysis results include a list of the profiles with the highest percentage of matching qualities. You can further narrow down the results by changing the priority of content types or individual content items. You can then view the percentage match for each content type.

How Best Fit Is Calculated

The best-fit analysis considers content items of only these predefined content types:

- Competencies
- Honors and awards
- Work requirements

**Note:** The work requirements content type does not have content items.

- Languages

**Note:** For languages, only the item Reading is considered in best-fit calculations.

- Degrees
- Memberships
- Licenses and certifications
You can use the Best-Fit feature to calculate the overall score for a target profile. The application calculates the overall best-fit score of the target profile with respect to the selected source profile based. The overall score is based on the individual score of each matching content item of the selected profile.

Overall Score in a Best-Fit Analysis: How It’s Calculated

The Best-Fit feature calculates the overall score for a target profile using an algorithm rule. The overall score appears in the Overall Fit column in the results section on the Find Best Fit page. The algorithm for the best-fit analysis is automatically processed by the application.

The following image shows the best-fit algorithm rule.

**Selected Profile**
The selected profile for which you want to find the profile that is the best-fit is source profile.

**Target Profile**
The target profile is the profile for which the overall score is calculated. The application compares the content items of the target profile with those of the source profile.
Individual Score
The individual score is the number assigned to each matching content item of the content types for which you specify the priority or importance. The individual score calculation algorithm depends on the best-fit analysis type.

Overall Score Calculation Rule
The overall score is the total of all individual scores of all matching content items. If the total of all individual scores includes decimals, then the application rounds off the total score to derive the overall score. The application rounds down the score if the decimal digit is less than 5. However, it increases the score by 1 if the decimal digit is 5 or more.

Examples:

- If the total score is 56.4, the overall score is 56.
- If the total score is 56.7, the overall score is 57.

Person to Person, Job to Person, and Job to Job Analyses: How the Individual Score is Calculated

In the following best-fit analyses, each content item of the selected profile must match the target profiles:

- Person to person
- Job to person
- Job to job

The individual score of each content item of the target profile is based on the priority set at the content type or content item level.
The following graphic shows how the individual score is calculated for each content of the selected profile that match with the target profile. The graphic is applicable for only person to person, job to person, and job to job analyses.

### Deciding the Priority

The best-fit algorithm uses the priority assigned to the content type or content item of the selected profile. The priority is used to decide the overall score of the target profile. Depending on the analysis type, you select the priority on the Find Best Fit Person or on the Find Best Fit Job page. You can either select a common priority value for all content items within a content type or specify priority using details.

To specify priority using details:

1. Select the **Priority Using Details** option on the Find Best Fit Person or Find Best Fit Job page.
2. Click the **Details** icon. The Best Fit Criteria page opens.
3. Specify the **Match** option for each content item within a content type. The value you select for the **Match** option is the priority value allocated at the content item level. The application calculates the individual score of each content item by considering the match value as the priority value for the content item.
Note: You can’t use the Priority Using Details option for the Work Requirements content type. The priority for this content type is always specified at the content type level. The application considers only the Travel Domestically and Travel Internationally work requirements for best-fit calculations. The application calculates the individual score of the Work Requirements content type for a target profile as follows:

- If both travel requirements of the source and target profiles match, then the Individual Score = Relative Weight \( \times 100 \).
- If only one travel requirement of the source and target profiles match, then the Individual Score = 0.5 \( \times \) Relative Weight \( \times 100 \).
- If none of the travel requirements of the source and target profiles match, then work requirements are ignored in best-fit calculations.

The priority of a content type is populated using the HRT_MATCH_IMPORTANCE lookup type values. Depending on the Match option value, the application calculates the score for each content item within a content type.

The following table illustrates the value of each priority level. These values are application-defined and can’t be modified.

<table>
<thead>
<tr>
<th>Priority Level</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>None</td>
<td>0</td>
</tr>
<tr>
<td>Low</td>
<td>1</td>
</tr>
<tr>
<td>Medium</td>
<td>2</td>
</tr>
<tr>
<td>High</td>
<td>3</td>
</tr>
<tr>
<td>Important</td>
<td>4</td>
</tr>
<tr>
<td>Very Important</td>
<td>5</td>
</tr>
<tr>
<td>Priority Using Details</td>
<td>Match of content item</td>
</tr>
</tbody>
</table>

Profile Ratings in Best-Fit Calculations
The overall score of a target profile also includes any ratings entered for the content items of the Competencies and Languages content types.

The Competencies content type uses the Proficiency rating model. The following table illustrates the default rating levels of the Proficiency Rating Model and corresponding value that application assigns to the rating level.

<table>
<thead>
<tr>
<th>Rating Level</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation</td>
<td>1</td>
</tr>
<tr>
<td>Intermediate</td>
<td>2</td>
</tr>
<tr>
<td>Skilled</td>
<td>3</td>
</tr>
</tbody>
</table>
The Languages content type uses the Language Rating Model. The following table illustrates the default rating levels of the Language Rating Model and corresponding value that application assigns to the rating level.

<table>
<thead>
<tr>
<th>Rating Level</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>1</td>
</tr>
<tr>
<td>Moderate</td>
<td>2</td>
</tr>
<tr>
<td>High</td>
<td>3</td>
</tr>
</tbody>
</table>

Relative Weight

The application calculates the relative weight of the content item for which you specify the priority at the content item or content type level. You specify the priority for the content types on the Best-Fit UI. The relative weight is the importance of a content item with respect to all the other content items in the source profile. The relative weight in the person to person, job to person, and job to job analyses is calculated only for the source profile content items. The relative weight is calculated using the following equation:

Relative Weight = Content item priority / Sum of all content items priorities

Example: The source profile content type has six content items for the Competencies content type and one content item for the Degrees content type. The priority is set at content type level. For the Competencies content type, the priority is set to Medium (2) and for the Degrees content type, it’s set to Low (1). The relative weight for each content item:

- In the Competencies content type = 2 / (2 + 2 + 2 + 2 + 2 + 2 + 1) = 2 / 13 = 0.153846
- In the Degrees content type = 1 / (2 + 2 + 2 + 2 + 2 + 2 + 1) = 1 / 13 = 0.076923

Relative Rating

If the content type with priority also has rating, the application calculates the relative rating of the content item associated with the content type. The relative rating is the rating of the content item in the target profile with respect to the source profile. The relative rating in the person to person, job to person, and job to job analyses is calculated using the following equation:

Relative Rating = Target Rating / Source Rating

Example: The rating level of a content item associated with the source and target profiles is 4 and 2 respectively. In this case, the relative rating for the content item in the target profile = 2 / 4 = 0.5.

Note: The relative rating is considered in the individual score calculation only when the source rating is greater than or equal to the target rating.
Individual Score of a Content Item

The individual score of a content item is calculated according to the criteria and the corresponding equation discussed in the following table. The table is applicable for person to person, job to person, and job to job analyses only.

<table>
<thead>
<tr>
<th>Content Type Has Rating?</th>
<th>Criteria</th>
<th>Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Not applicable</td>
<td>Individual score = Relative Weight * 100</td>
</tr>
<tr>
<td>Yes</td>
<td>Target Rating &gt; or = Source Rating</td>
<td>Individual score = Relative Weight * 100</td>
</tr>
<tr>
<td>Yes</td>
<td>Target Rating &lt; Source Rating</td>
<td>Individual score = Relative Rating * Relative Weight * 100</td>
</tr>
</tbody>
</table>

In the earlier table:

- Target Rating is the rating level associated with a content item of the target profile
- Source Rating is the rating level associated with a content item of the source profile
- Relative Weight = Content item priority / Sum of all content items priorities
- Relative Rating = Target Rating / Source Rating

Related Topics

- Rating Models: Explained

Person to Job Analysis: How the Individual Score is Calculated

In the person to job analysis, each content item of the target job profile must match the selected person profile. The individual score of each content item of the target job profile is based on the importance of the content item.
The following graphic shows how the individual score is calculated for each content item of the target job profile. The content item must match with the corresponding content item in the selected person profile. The graphic is applicable only for the person to job analysis.

**Verifying the Importance**

When you do a person to job analysis, the best-fit algorithm utilizes the importance of all content associated with a target job to find the best-fit job for the selected person profile. The option to enter the priority for a person profile type is disabled on the UI.
The importance for the Work Requirements content type is always specified at the content type level. The application considers only the work requirement properties Travel Domestically and Travel Internationally for best-fit calculations. The application calculates the individual score of the Work Requirements content type as follows:

- If both travel requirements of the source and target profiles match, then the Individual Score = Relative Weight * 100.
- If only one travel requirement of the source and target profiles match, then the Individual Score = 0.5 * Relative Weight * 100.
- If none of the travel requirements of the source and target profiles match, then work requirements are ignored in best-fit calculations.

The importance of a content type is populated using the HRT_MATCH_IMPORTANCE lookup type values.

**Profile Ratings in Best-Fit Calculations**

Any ratings entered for the content items of the content type competencies and languages are also used in the calculation of the overall score of a target profile.

The Competencies content type uses the Proficiency rating model. The following table illustrates the default rating levels of the Proficiency Rating Model and corresponding value that application assigns to the rating level.

<table>
<thead>
<tr>
<th>Rating Level</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Foundation</td>
<td>1</td>
</tr>
<tr>
<td>Intermediate</td>
<td>2</td>
</tr>
<tr>
<td>Skilled</td>
<td>3</td>
</tr>
<tr>
<td>Advanced</td>
<td>4</td>
</tr>
<tr>
<td>Expert</td>
<td>5</td>
</tr>
</tbody>
</table>

The Languages content type uses the Language Rating Model. The following table illustrates the default rating levels of the Language Rating Model and corresponding value that application assigns to the rating level.

<table>
<thead>
<tr>
<th>Rating Level</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Low</td>
<td>1</td>
</tr>
<tr>
<td>Moderate</td>
<td>2</td>
</tr>
<tr>
<td>High</td>
<td>3</td>
</tr>
</tbody>
</table>
Relative Weight

The application calculates the relative weight of the content item for which the importance is specified at the content item or content type level. The relative weight is the importance of a content item of the job profile with respect to all the other content items in the job profile. The relative weight in the person to job analysis is calculated only for the target profile content items using the following equation:

Relative Weight = Content item priority / Sum of importance for all content items

Example: The target job profile has in all three content types Competencies, Degrees, and Languages. The Competencies content type has in all six content items, the Degrees content type has one content item, and the Languages content type has one content item. The target importance already specified for each content item in Competencies and Degrees is Medium (2) and for Languages is Low (1). The relative weight for each content item:

- In the Competencies content type = 2 / (2 + 2 + 2 + 2 + 2 + 2 + 2 + 1) = 2 / 15 = 0.133333
- In the Degrees content type = 1 / (2 + 2 + 2 + 2 + 2 + 2 + 2 + 1) = 2 / 15 = 0.133333
- In the Languages content type = 1 / (2 + 2 + 2 + 2 + 2 + 2 + 2 + 1) = 1 / 15 = 0.066667

Relative Rating

If the content type for which the importance is specified has a rating, the application calculates the relative rating of the content item associated with the content type. The relative rating is the rating of the content item in the source profile with respect to the target profile. The relative rating in the person to job analysis is calculated using the following equation:

Relative Rating = Source Rating / Target Rating.

Example: The rating level of a content item associated with the source and target profiles is 2 and 4 respectively. In this case, the relative rating for the content item = 2 / 4 = 0.5.

Note: The relative rating is considered in the individual score calculation only when the target rating is greater than or equal to the source rating.

Individual Score of a Content Item

The individual score of a content item is calculated according to the criteria and the corresponding equation discussed in the following table. The table is applicable for a person to job analysis only.

<table>
<thead>
<tr>
<th>Content Type Has Rating?</th>
<th>Criteria</th>
<th>Equation</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td>Not applicable</td>
<td>( \text{Individual score} = \text{Relative Weight} \times 100 )</td>
</tr>
<tr>
<td>Yes</td>
<td>Target Rating &lt; Source Rating</td>
<td>( \text{Individual score} = \text{Relative Weight} \times 100 )</td>
</tr>
<tr>
<td>Yes</td>
<td>Target Rating ( \geq ) Source Rating</td>
<td>( \text{Individual score} = \text{Relative Rating} \times \text{Relative Weight} \times 100 )</td>
</tr>
</tbody>
</table>

In the earlier table:
- Target Rating is the rating level associated with the content item of the target job profile
- Source Rating is the rating level associated with the content item of the source person profile
- Relative Weight = Content item priority / Sum of all content items priorities
• Relative Rating = Source Rating / Target Rating

Related Topics
• Rating Models: Explained

Best-Fit Analysis: Examples

Use the best-fit analysis to find the profiles that most closely match a selected profile. You select a person or job profile (job or position) as a source profile and use the Best-Fit feature to find profiles that best match the source profile. The best-fit analysis results are based on how well the content items of a target profile match content items of the source profile.

Best-Fit Person Profile

As an HR specialist, you want to find the best-fit person profile for John.

John’s person profile has the following content:

• Competencies as shown in the following table.

<table>
<thead>
<tr>
<th>Competencies (Content Item)</th>
<th>Proficiency</th>
<th>Numeric Value of Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Oriented</td>
<td>Expert</td>
<td>5</td>
</tr>
<tr>
<td>Adapt Productively</td>
<td>Advanced</td>
<td>4</td>
</tr>
<tr>
<td>Communication</td>
<td>Expert</td>
<td>5</td>
</tr>
</tbody>
</table>

• Degrees:
  ◦ Bachelor of Engineering
  ◦ Master of Business Administration

• Language with details as shown in the following table.

<table>
<thead>
<tr>
<th>Languages (Content Item)</th>
<th>Reading (Rating Value)</th>
<th>Writing (Rating Value)</th>
<th>Speaking (Rating Value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Moderate (2)</td>
<td>Low (1)</td>
<td>High (3)</td>
</tr>
</tbody>
</table>

• Work Requirements:
  ◦ Travel Domestically: No
  ◦ Travel Internationally: No

You set the priority for the John’s profile content on the best-fit person UI as illustrated in the following table and perform the Find Best Fit Person action on John’s person profile.

<table>
<thead>
<tr>
<th>Content</th>
<th>Priority (Numeric Value of the priority)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies</td>
<td>Medium (2)</td>
</tr>
</tbody>
</table>
In the results section, for an overall fit greater than 50%, the application displays the target person profile Alex.

Alex’s person profile has the following content details:

- Competencies as shown in the following table.

<table>
<thead>
<tr>
<th>Competencies (Content Item)</th>
<th>Proficiency</th>
<th>Numeric Value of Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communication</td>
<td>Advanced</td>
<td>4</td>
</tr>
<tr>
<td>Problem Solving</td>
<td>Skilled</td>
<td>3</td>
</tr>
</tbody>
</table>

- Degrees:
  - Bachelor of Engineering
  - Diploma

- Languages as shown in the following table.

<table>
<thead>
<tr>
<th>Languages (Content Item)</th>
<th>Reading (Rating Value)</th>
<th>Writing (Rating Value)</th>
<th>Speaking (Rating Value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>High (3)</td>
<td>Moderate (2)</td>
<td>Low (1)</td>
</tr>
<tr>
<td>French</td>
<td>Low (1)</td>
<td>Low (1)</td>
<td>Low (1)</td>
</tr>
</tbody>
</table>

- Work Requirements:
  - Travel Domestically: No
  - Travel Internationally: No

For the best-fit calculation, the application considers the individual score of the following four content items of Alex’s person profile that match with the content items of John’s person profile:

- Competencies: Communication
- Degrees: Bachelor of Engineering
• Languages: English
• Work Requirements: Travel Domestically and Travel Internationally

The following table illustrates the overall score calculation of Alex’s person profile.

<table>
<thead>
<tr>
<th>Content</th>
<th>Source Priority</th>
<th>Source Rating</th>
<th>Target Rating</th>
<th>Relative Weight</th>
<th>Individual Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies (Communication)</td>
<td>2</td>
<td>5</td>
<td>4</td>
<td>0.1428571</td>
<td>11.428568</td>
</tr>
<tr>
<td>Degrees (Bachelor of Engineering)</td>
<td>2</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>0.1428571</td>
<td>14.28571</td>
</tr>
<tr>
<td>Languages (English)</td>
<td>2</td>
<td>2</td>
<td>3</td>
<td>0.1428571</td>
<td>14.28571</td>
</tr>
<tr>
<td>Work Requirements</td>
<td>2</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>0.1428571</td>
<td>14.28571</td>
</tr>
</tbody>
</table>

Total Score = 54.285698

Overall Score = 54

The overall score is calculated as follows:

• The source profile John has in all seven content items with the priority for all content items set to Medium (2) at the content type level. Therefore, the relative weight for each content item = (2 / 14) = 0.1428571 (where, Relative Weight= Content item priority/Sum of all content item priorities).

• The application calculates the individual score of the matching content using the appropriate equation as displayed in the following table.

<table>
<thead>
<tr>
<th>Content</th>
<th>Criteria</th>
<th>Relative Rating</th>
<th>Individual Score Equation</th>
<th>Individual Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies (Communication)</td>
<td>Target Rating &lt; Source Rating</td>
<td>Target Rating / Source Rating = 4 / 5</td>
<td>Individual Score = Relative Rating * Relative Weight * 100</td>
<td>(4 / 5) * 0.1428571 * 100 = 11.428568</td>
</tr>
<tr>
<td>Degrees (Bachelor of Engineering)</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Individual Score = Relative Weight * 100</td>
<td>0.1428571 * 100 = 14.28571</td>
</tr>
<tr>
<td>Languages (English)</td>
<td>Target Rating &gt; Source Rating</td>
<td>Not applicable</td>
<td>Individual Score = Relative Weight * 100</td>
<td>0.1428571 * 100 = 14.28571</td>
</tr>
<tr>
<td>Work Requirements</td>
<td>Both travel requirements, Travel Domestically and Travel Internationally, of source and target profiles matches.</td>
<td>Not applicable</td>
<td>Individual Score = Relative Weight * 100</td>
<td>0.1428571 * 100 = 14.28571</td>
</tr>
</tbody>
</table>

• The total score is the sum of all individual scores. Therefore, total score = 54.285698.
• The application rounds off the total score to the nearest whole number. Therefore, the overall score of the target profile is displayed as 54.

Best-Fit Job Profile
As an HR specialist, you want to find the best-fit job profile for the person profile for Beth.

Beth’s person profile has the following content:

• Competencies as shown in the following table.

<table>
<thead>
<tr>
<th>Competency (Content Item)</th>
<th>Proficiency</th>
<th>Numeric Value of Rating</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Oriented</td>
<td>Intermediate</td>
<td>2</td>
</tr>
<tr>
<td>Communication</td>
<td>Intermediate</td>
<td>2</td>
</tr>
<tr>
<td>Leading People</td>
<td>Foundation</td>
<td>1</td>
</tr>
<tr>
<td>Working Globally</td>
<td>Intermediate</td>
<td>2</td>
</tr>
</tbody>
</table>

• Degrees: Technical Diploma

• Language as shown in the following table.

<table>
<thead>
<tr>
<th>Language (Content Item)</th>
<th>Reading (Rating Value)</th>
<th>Writing (Rating Value)</th>
<th>Speaking (Rating Value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Low (1)</td>
<td>Moderate (2)</td>
<td>Low (1)</td>
</tr>
</tbody>
</table>

• Memberships: ICAS

You perform the Find Best Job action on Beth’s person profile. In the results section, for an overall fit greater than 40%, the application displays the job profile Accountant.

**Note:** In the person to job best-fit analysis, you can't set the priority on the best-fit job UI. Instead, the application considers the importance of the content items of the target job profile for best-fit calculations.

The target job profile Accountant has the following content types with the importance already specified for each content item or content type:

• Competencies as shown in the following table.

<table>
<thead>
<tr>
<th>Competency (Content Item)</th>
<th>Proficiency (Numeric Value)</th>
<th>Importance (Numeric Value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Action Oriented</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Communication</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Leading People</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Working Globally</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Competency (Content Item)</td>
<td>Proficiency (Numeric Value)</td>
<td>Importance (Numeric Value)</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-----------------------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Analytical Skills</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Embrace Change</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Manage Risk</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Market and Industry Knowledge</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Resource Management</td>
<td>Intermediate (2)</td>
<td>Medium (2)</td>
</tr>
</tbody>
</table>

- Degrees as shown in the following table.

<table>
<thead>
<tr>
<th>Content Item</th>
<th>Importance (Numeric Value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Technical Diploma</td>
<td>Medium (2)</td>
</tr>
</tbody>
</table>

- Languages as shown in the following table.

<table>
<thead>
<tr>
<th>Language (Content Item)</th>
<th>Reading (Rating Value)</th>
<th>Writing (Rating Value)</th>
<th>Speaking (Rating Value)</th>
<th>Importance</th>
</tr>
</thead>
<tbody>
<tr>
<td>English</td>
<td>Low (1)</td>
<td>Low (1)</td>
<td>Medium (2)</td>
<td>Medium (2)</td>
</tr>
</tbody>
</table>

- Memberships

<table>
<thead>
<tr>
<th>Content Item</th>
<th>Importance (Numeric Value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICAS</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>CIMA</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>ACCA</td>
<td>Medium (2)</td>
</tr>
</tbody>
</table>

- Work Requirements:

<table>
<thead>
<tr>
<th>Requirements</th>
<th>Importance (Numeric Value)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Travel Domestically: No</td>
<td>Medium (2)</td>
</tr>
<tr>
<td>Travel Internationally: No</td>
<td>Medium (2)</td>
</tr>
</tbody>
</table>
For the best-fit calculation, the application considers the individual score of the following 7 content items of the job profile Accountant that match with the content items of Beth:

- Competencies: Action Oriented, Communication, Leading People, Working Globally
- Degrees: Technical Diploma
- Languages: English
- Memberships: ICAS

The following table illustrates the overall score calculation of the target job profile Accountant.

<table>
<thead>
<tr>
<th>Content</th>
<th>Target Importance</th>
<th>Source Rating</th>
<th>Target Rating</th>
<th>Relative Weight</th>
<th>Individual Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies (Action Oriented)</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>0.066667</td>
<td>6.6667</td>
</tr>
<tr>
<td>Competencies (Communication)</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>0.066667</td>
<td>6.6667</td>
</tr>
<tr>
<td>Competencies (Leading People)</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>0.066667</td>
<td>3.33335</td>
</tr>
<tr>
<td>Competencies (Working Globally)</td>
<td>2</td>
<td>2</td>
<td>2</td>
<td>0.066667</td>
<td>6.6667</td>
</tr>
<tr>
<td>Degrees (Technical Diploma)</td>
<td>2</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>0.066667</td>
<td>6.6667</td>
</tr>
<tr>
<td>Languages (English)</td>
<td>2</td>
<td>1</td>
<td>2</td>
<td>0.066667</td>
<td>6.6667</td>
</tr>
<tr>
<td>Memberships (ICAS)</td>
<td>2</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>0.066667</td>
<td>6.6667</td>
</tr>
<tr>
<td><strong>Total Score</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>43.3335</strong></td>
</tr>
<tr>
<td><strong>Overall Score</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td><strong>43</strong></td>
</tr>
</tbody>
</table>

The overall score is calculated as follows:

- The target job profile Accountant has in all 15 content items with the importance (or priority) for all content items at the content type level set to 2. Therefore, the relative weight for each content item = 2 / 30 = 0.066667 (where, Relative Weight = Content item importance / Sum of all content item importance).
- The application calculates the individual score of the matching content using the appropriate equation as displayed in the following table.

<table>
<thead>
<tr>
<th>Content</th>
<th>Criteria</th>
<th>Relative Rating</th>
<th>Individual Score Equation</th>
<th>Individual Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies (Action Oriented)</td>
<td>Target Rating = Source Rating</td>
<td>Source Rating / Target Rating = 2 / 2</td>
<td>Individual Score = Relative Rating * Relative Weight * 100</td>
<td>(2 / 2) * 0.066667 * 100 = 6.6667</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Using Goal Management

#### Chapter 2

### Talent Profiles

<table>
<thead>
<tr>
<th>Content</th>
<th>Criteria</th>
<th>Relative Rating</th>
<th>Individual Score Equation</th>
<th>Individual Score</th>
</tr>
</thead>
<tbody>
<tr>
<td>Competencies (Communication)</td>
<td>Target Rating = Source Rating</td>
<td>Source Rating / Target Rating = 2 / 2</td>
<td>Individual Score = Relative Rating * Relative Weight * 100</td>
<td>(2 / 2) * 0.066667 * 100 = 6.6667</td>
</tr>
<tr>
<td>Competencies (Leading People)</td>
<td>Target Rating &gt; Source Rating</td>
<td>Source Rating / Target Rating = 1 / 2</td>
<td>Individual Score = Relative Rating * Relative Weight * 100</td>
<td>(1 / 2) * 0.066667 * 100 = 3.33335</td>
</tr>
<tr>
<td>Competencies (Working Globally)</td>
<td>Target Rating = Source Rating</td>
<td>Source Rating / Target Rating = 2 / 2</td>
<td>Individual Score = Relative Rating * Relative Weight * 100</td>
<td>(2 / 2) * 0.066667 * 100 = 6.6667</td>
</tr>
<tr>
<td>Degrees (Technical Diploma)</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Individual Score = Relative Weight * 100</td>
<td>0.066667 * 100 = 6.6667</td>
</tr>
<tr>
<td>Languages (English)</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Individual Score = Relative Weight * 100</td>
<td>0.066667 * 100 = 6.6667</td>
</tr>
<tr>
<td>Memberships (ICAS)</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>Individual Score = Relative Weight * 100</td>
<td>0.066667 * 100 = 6.6667</td>
</tr>
</tbody>
</table>

- The total score is the sum of all individual scores. Therefore, total score = 43.3335.
- The application rounds off the total score to the nearest whole number. Therefore, the overall score of the target profile is displayed as 43.

**Related Topics**

- Rating Models: Explained

### FAQs for Compare Profiles and Find the Best Fit

**How are the differences between comparison attributes identified?**

The differences are calculated between the attributes of the secondary items and the base item. Differences between numeric values are calculated and displayed; character differences are indicated using an icon.

When the data includes a range (competency ratings, for example), the comparison displays the differences from each end of the range. The comparison, however, doesn’t display the differences for values that lie within the range. For example, consider that you are comparing the competency requirements of two job profiles. The competency requirement of the base job is between 2 and 4 and the secondary job is between 1 and 3. The comparison displays the difference between the minimum competency requirement of the secondary job (1) and the base job (2) as -1. The comparison doesn’t display the difference between the maximum values because the maximum competency requirement of the secondary job (3) lies within the competency requirement of the base job (between 2 and 4).
How is risk of loss assessed?

Line managers and human resource specialists enter the risk of loss information in a person’s profile manually; there is no automated risk assessment process. They evaluate the risk of workers changing jobs or leaving the enterprise and select the ratings.

Can I add additional data sets to the comparison?

No, you can only select from the list of data sets available for an item type.

What happens if I remove the comparison base?

The next item in the comparison is automatically designated as the comparison base and the differences from the new base item are indicated. Note that the comparison must always include a base item.

What's the difference between performing a best-fit analysis and comparing profiles?

Perform a best-fit analysis to find matching profiles for a specified profile using a wide variety of criteria. For example, use best-fit analysis to find the top five person profiles matching a job profile, based on competency requirements, language skills, and certifications.

Compare profiles to evaluate the similarities and differences between known profiles and identify the most suitable profiles. For example, compare the five person profiles identified by the best-fit analysis and identify the person most suited to the job.

To compare or perform a best-fit analysis, use the Compare action in the smart navigation.

Creating and Updating Profiles

Model Profiles: Explained

Model profiles identify the competencies, qualifications, skills, and experience required for a workforce structure, such as a job or position. Use the Manage Model Profiles task in the Profiles work area to create a model profile.

You must use the job profile type to create model profiles. Jobs and positions are workforce structures optionally included in a profile. A job or position profile can exist as an abstract profile that just groups requirements and doesn’t reference an existing or planned job or position.

Note: You must use the Job profile type to create model profiles.
Workforce Structure

You can optionally associate the model profile with a workforce structure. The available workforce structures depend on how the profile type is defined. The workforce structures are limited to jobs, positions, organizations, and job families. However, to create a model profile you must use the Job profile type as the template.

You can associate:

- A model profile with more than one workforce structure. Associating model profiles with jobs and positions enables you to define for the job or position the competencies, educational qualifications, and other skills that are required.
- Multiple model profiles with a workforce structure. However, only one profile can be in effect at a time for the workforce structure. Therefore, the effective start and end dates of multiple profiles associated with a workforce structure must not overlap.

When you associate jobs and positions with a model profile, you can compare profiles and use the best-fit analysis for tasks such as finding the worker best-suited for a job or for helping workers identify their next career moves.

Requirements

Identify requirements for the model profile by selecting from the content types. For example, the job profile type might contain these content types: competencies, degrees, honors and awards, languages, licenses and certifications, memberships, and work requirements. If you create a model profile, you can define the requirements for the job using content items in those content types. To add other content types, you must first add them to the job profile type.

Note: A free-form content type contains only a code, name, and a description, and doesn’t have any properties until you add it to a profile type. Free-form content types don’t include any content items.

Performance Document Information

You can configure a performance template section to populate competencies defined for a model profile in the performance document. Weights and minimum weights associated with competencies from a model profile are also populated in the performance document when:

- The performance document is created.
- New competencies are added to the model profile and the performance document is updated.

Related Topics

- Profile Types: Explained
- Performance Template Section: Critical Choices

Jobs and Positions: How They Work with Model Profiles

You can associate a model profile with a job or a position. This association enables you to define the work requirements and the required competencies, degrees, and other skills for the job or position. This association also enables you to compare profiles and use the best-fit analysis for tasks such as finding the worker best-suited for a job or for helping workers identify their next career moves.
This figure illustrates the information that is contained in a model profile versus that contained in a job.

**Job Profile: Senior Network Analyst**
- **Competencies:** Problem Solving, Planning and Organizing, Results Orientation, Coaching
- **Languages:** English, Spanish
- **Degrees:** Master of Business Administration, Master of Information Technology

**Job: Senior Network Analyst**
- **Status:** Active
- **Full Time or Part Time:** Full Time
- **Regular or Temporary:** Regular
- **Management Level:** None

**Associating a Model Profile with a Job or Position**
You must use the Job profile type to create model profiles and associate them with a job or position. You can have only one association with a model profile active at one time.

**Editing a Profile**
You can associate a model profile with multiple jobs and positions. Use the Manage Model Profiles task in the Profiles work area to:

- Create or edit model profiles by using the Job profile type
- Associate model profiles with jobs and positions
- Remove associations between a model profile and jobs or positions

**Related Topics**
- Jobs and Positions: Critical Choices
- Profile Types: Explained

**Creating Job Profiles: Procedure**
You can associate a job profile with a job to define the work requirements and the required competencies, degrees, and other skills for the job. Using this association, you can compare job profiles and use the best-fit analysis to:

- Find the worker best-suited for a job.
• Help workers identify their next career moves.

You must use the Job profile type to create profiles for jobs. To create a job profile:

1. Sign in as an HR specialist.
3. On the Search Results section toolbar, click Create to open the Create Model Profile dialog box.
4. On the Tasks tab in the right panel, click Manage Model Profiles to open the Manage Model Profiles page.
5. From the Profile Type list, select Job.
6. Enter values for the fields shown in the following table.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Enter a unique code for the profile.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a unique name for the profile.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the profile.</td>
</tr>
</tbody>
</table>

7. Click OK to open the Job Profile page.
8. Expand Workforce Structures.
10. From the Workforce Structure list, select Job.
11. From the Name list, search for and select the job with which you want to associate the profile.
12. In the Effective Start Date field, enter the date from which you want to associate the profile with the job. If multiple profiles exist for a job, ensure that their dates in the Effective Start Date and Effective End Date fields don’t overlap.
13. In the Effective End Date field, enter the date until when you want to associate the profile with the job.
14. In the Requirements section, add required content types.
15. Click Submit. An active job profile for the selected job was created using the Job profile type.

Related Topics
• Profile Types: Explained
• Content Types: Explained
• Content Section Properties: Explained

Creating Position Profiles: Procedure

You can associate a position profile with position to define the work requirements and the required competencies, degrees, and other skills for the position. Using this association, you can compare position profiles and use the best-fit analysis to:

• Find the worker best-suited for a position.
• Help workers identify their next career moves.

You must use the Job profile type to create profiles for positions. To create a position profile:

1. Sign in the application as an HR specialist.
3. On the Tasks tab in the right panel, click Manage Model Profiles to open the Manage Model Profiles page.
4. On the Search Results section toolbar, click Create to open the Create Model Profile dialog box.
5. From the Profile Type list, select Job.
6. Enter values for the fields shown in the following table.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Enter a unique code for the profile.</td>
</tr>
<tr>
<td>Name</td>
<td>Enter a unique name for the profile.</td>
</tr>
<tr>
<td>Description</td>
<td>Enter a description for the profile.</td>
</tr>
</tbody>
</table>

7. Click OK to open the Job Profile page.
8. Expand Workforce Structures.
10. From the Workforce Structure list, select Position.
11. From the Name list, search for and select the position with which you want to associate the profile.
12. In the Effective Start Date field, enter the date from which you want to associate the profile with the position. At a time, you can associate only one active profile with a position. If multiple profiles exists for a position, ensure that their dates in the Effective Start Date and Effective End Date fields don’t overlap.
13. Optional: In the Effective End Date field, enter the date until when you want to associate the profile with the position.
14. In the Requirements section, add required content types.
15. Click Submit. An active model profile for the selected position was created using the Job profile type.

Related Topics

- Profile Types: Explained
- Content Types: Explained
- Content Section Properties: Explained

Identifying Job and Position Risk: Explained

Use the Job or Position Risk content section within a model profile to identify the level of risk if the job or position is vacant. This content section is available on the job and position model profile types. Use the Manage Profile Types task in the Profiles work area to manage job and position profile types.

Risk Level and Reason

You can enter a level of risk and the reasons for the level of risk, such as skills gaps, future business leadership, market volatility, and organization hierarchy. You can select up to five reasons for risk.

Succession Planning

The Job or Position Risk content section also includes an option to indicate whether the job or position must be included in a succession plan.
Creating Person Profiles: Explained

The person profile is a profile type you create for individual workers. Person profile data, such as the skills, qualifications, accomplishments, and career preferences of a person, is displayed on Skills and Qualifications and Career Planning pages on a worker’s person profile. HR specialists or implementors can create person profiles from the application, or implementors can upload them using tools such as HCM Data Loader.

The application provides the functionality to automatically create person profiles for person records. You can enable or disable this functionality using the Autocreate Person Profiles check box. By default, this check box is already selected. The Autocreate Person Profiles check box is available on the Edit Profile Type page of the person profile type. Use the Manage Profile Types task in the Profiles or Setup and Maintenance work area to edit the person profile type.

When the Autocreate Person Profiles check box is selected:

- The application automatically creates the person profile for that person when someone accesses the Skills and Qualifications page for a person.
- The person profile added for a pending worker is activated on the effective hire date for an employee or the effective placement date for a contingent worker.

If you choose to deselect the Autocreate Person Profiles check box for the person profile type and no profile exists for a person, the application displays an error message to create or upload profile when you access that person’s Skills and Qualifications page. However, when uploading talent profile data from external sources, you must deselect the Autocreate Person Profiles check box to avoid duplication of person profiles.

Related Topics

- Person Records: Explained

Adding Content to a Worker's Profile: Procedure

Depending on the content section access settings for HR specialists and managers, they can edit content or add it to a worker’s profile. To view, add, or edit content of a worker’s profile, they must use the worker’s Skills and Qualifications page.

As an HR specialist, follow these steps to either edit the content or add it to the worker’s profile:

1. Click My Client Groups > Profiles to open the Search: Profiles page.
2. Click the name of the worker in the Results section to open the Skills and Qualifications page of that worker.

   Tip: Alternatively, use the Manage Talent Profile task in the Person Management work area to open a person’s Skills and Qualifications page.

3. Click Edit on the Skills and Qualifications page to either edit the content, or add it to the worker’s profile.

As a manager, follow these steps to either edit the content or add it to a report’s profile:

1. Click My Team > Team Talent.
2. Click a report’s person card to open the Skills and Qualifications page for the report.
3. Click Edit on the Skills and Qualifications page to either edit the content, or add it to the report’s profile.
Uploading Talent Profile Data: Explained

Talent profile data is the person and job profiles data displayed on Skills and Qualifications and Career Planning pages. You access these pages for a worker in the worker’s person spotlight. Examples of talent profile data include ratings and corresponding rating models, content items, and educational establishments. You can upload talent profile data for initial migration or mass data entry.

The following tools support upload of talent profile data:

- Oracle ADF Desktop Integration (ADFdi) workbook
- Oracle Fusion HCM Data Loader
- Oracle Fusion HCM Spreadsheet Data Loader

**Note:** The tools available to you for uploading talent profile data depend on the setting of the HCM Data Loader Scope parameter. The ADFdi workbook isn’t affected by the HCM Data Loader Scope parameter. You can continue to upload competencies using the ADFdi workbook regardless of the parameter setting.

For more information about:

- Uploading content items using an ADFdi workbook, see Uploading Competencies and Content Items into Oracle Fusion Profile Management (1453118.1) on My Oracle Support at https://support.oracle.com.
- All data loaders mentioned earlier, see Oracle Human Capital Management Cloud Integrating with Oracle HCM Cloud Guide.

Uploading Actions

The following table displays the type of talent profile data you typically upload and the actions you perform to load that data.

**Note:** Use the Open Competency Excel Template option to generate the ADFdi workbook for uploading competencies. The option is available on the Manage Content Items page in the Profiles work area.

<table>
<thead>
<tr>
<th>Uploading Tool</th>
<th>Talent Profile Data Type</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>ADFdi workbook</td>
<td>Content Item (only Competency)</td>
<td>Create, Update</td>
</tr>
<tr>
<td>HCM Data Loader</td>
<td>Educational establishment</td>
<td>Create, Update</td>
</tr>
<tr>
<td></td>
<td>Talent profile rating model</td>
<td>Update, Delete</td>
</tr>
<tr>
<td></td>
<td>Talent profile type (only Person and Job)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Talent profile content item</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Talent profile content item relationship</td>
<td></td>
</tr>
<tr>
<td>HCM Spreadsheet Data Loader</td>
<td>Educational establishment</td>
<td>Create, Update</td>
</tr>
<tr>
<td></td>
<td>Talent profile rating model</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Talent profile type (only Person and Job)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Talent profile content item</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Talent profile content item relationship</td>
<td></td>
</tr>
</tbody>
</table>
Using Desktop Integrated Excel Workbooks: Points to Consider

**Related Topics**

- Using Desktop Integrated Excel Workbooks: Points to Consider

**Updating Talent Ratings: Explained**

Talent ratings are ratings that are used to evaluate a worker, including performance, potential, proficiency, readiness, and impact. Ratings are used in multiple products within the HCM product family such as Oracle Fusion Profile Management, Oracle Fusion Performance Management, and Oracle Fusion Talent Review.

**Talent Rating Types**

The following table displays the talent ratings and their description. Depending on application settings and roles assigned, you can view, add, and update these talent ratings across multiple products within the HCM product family.

<table>
<thead>
<tr>
<th>Talent Ratings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Talent score</td>
<td>Evaluate a person’s overall value to the organization using a rating model your organization defines.</td>
</tr>
<tr>
<td>Performance rating</td>
<td>Evaluate an item, section, or overall performance document.</td>
</tr>
<tr>
<td>Potential level</td>
<td>Evaluate a person based on the execution of the person’s work.</td>
</tr>
<tr>
<td>Potential score</td>
<td>Evaluate a person’s attainable level of excellence or ability to achieve success.</td>
</tr>
<tr>
<td>N box cell assignment</td>
<td>Evaluate a person’s current contribution and potential contribution to the organization on a box chart matrix with N boxes. N represents the number of boxes in the grid.</td>
</tr>
<tr>
<td>Advancement readiness</td>
<td>Evaluate a person’s readiness for the next position in their career development.</td>
</tr>
<tr>
<td>Risk of loss</td>
<td>Evaluate the likelihood of a person leaving the company.</td>
</tr>
<tr>
<td>Impact of loss</td>
<td>Evaluate the real or perceived effects on an organization when the person leaves.</td>
</tr>
<tr>
<td>Proficiency</td>
<td>Evaluate a person’s skill level for a competency.</td>
</tr>
<tr>
<td>Behavior ratings</td>
<td>Evaluate a person’s actions for a behavior associated with a competency.</td>
</tr>
</tbody>
</table>

**Updating Talent Ratings**

You can update talent ratings depending on application settings and roles assigned to you. The following table shows where talent ratings can be updated.
### Talent Profiles

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Talent score</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Performance rating</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Potential level</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Potential score</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>N box cell assignment</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Advancement readiness</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Risk of loss</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Impact of loss</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Proficiency</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note:** You can update Behavior ratings under Competencies on the Edit Skills and Qualifications page for a person.

When you update talent ratings:

- The performance rating on a performance document is always the one entered by the manager during a worker’s performance evaluation. The performance rating from the worker’s performance document is then displayed on the worker’s profile when configured to do so in the performance template.

- In Oracle Fusion Compensation Management, if configured, you can also update the performance, performance goals section, and competencies section ratings, which appear in performance documents.

- The talent review process uses talent ratings on the worker’s profile to build talent review information. When a talent review meeting concludes, a worker’s profile is automatically updated with the calibrated ratings. Therefore, the performance rating displayed in a worker’s performance document might be different from the one displayed in the worker’s profile.

**Related Topics**

- Performance Ratings: Points to Consider

- Rating Models: Explained

**FAQs for Creating and Updating Profiles**
What happens if I change the status of a model profile to inactive?

If you change the status of a model profile associated with a job or position to inactive, the model profile is no longer available. The profile is visible only to an administrator. The profile isn’t available when you perform a best-fit analysis or a comparison of profiles, or when you search for model profiles. Any workforce structures that were associated with the inactive model profile are made available to associate with another active model profile.

The profile is also removed from workers’ interest lists. A notification is sent to HR specialists and managers, and to those workers who have the profile in their interest list.

**Related Topics**

- Profile Types: Explained
- Content Types: Explained
- Content Section Properties: Explained

What's a competency gap chart?

A competency gap chart is a graphical representation of how well your competency ratings match the required proficiency ratings of a job or position profile. The job or position profiles to which you can compare your profile include your assignments and the profiles in your interest list. The application generates competency gap chart using only those competencies that appear in both your profile and the selected job or position profile. Select Navigator > Me > Skills and Qualifications to view the competency gap chart on the Skills and Qualifications page. You can also view the competency gap chart for each explored role or roles added as careers of interest in the Career Development work area.

Use the competency gap chart in your career development to determine whether you’re already qualified for the selected job or position, or if areas exist where you need further development. If you identify gaps, you or your manager can also add a goal for the competency for which you have lesser ratings in the Career Development work area. For example, if your rating for the Leadership competency is 3 and the targeted rating for that competency in the Product Manager job is 4, you might research training classes or ask for projects that would help you improve your leadership capabilities. In the Career Development work area, you can also add a goal to the Leadership competency to help you improve your leadership capabilities.

If the job or position profile contains fewer than three competencies, then the competency gap chart is displayed as a bar chart. Otherwise, the chart is displayed as a radar chart. The compatible percentage for a role is automatically calculated using the best-fit analysis tool.

**Related Topics**

- Career Development: Explained

What's a career statement?

A career statement is a summary of your career goals. You can enter your career statement on your Career Planning page or on the My Career Development page. Anyone who can view your career planning information can view your career statement.

To open your Career Planning page, select Navigator > Me > Career Planning. In the Career Development work area, you can view the career statement using the Overview or Career Preferences infotile.

Career statements are for informational purposes only.
Why did the potential level change when I changed the potential score?

The relationship between the potential score and potential level is defined in the potential rating model. When you change the potential level, the application updates the potential score with the numeric rating for that level. When you change the potential score, the application updates the potential level with the level in the rating model that has a numeric rating closest to the potential score. To change a talent rating of your direct report, click the Edit icon in the Talent Ratings section on the Career Planning page of the selected report’s person spotlight. To access a direct report’s person spotlight:

- Select Directory > Directory, search for the worker, and click the worker’s name in the search results
- Select My Team > My Team and click the worker’s name on the My Team page
- Select My Team > Team Talent and click the worker’s name on the Team Talent page
- Select My Team > Team Compensation and click the worker’s name on the Team Compensation page
- Open the person smart navigation window from application pages

For example, assume the first two rating levels in the potential rating model contain numeric ratings 1.5 and 2, respectively. If you assign a potential score of 1.7 to a worker, then the potential level for the worker is updated with the first potential level in the rating model, because 1.7 is closer to the numeric rating of 1.5 than it’s to the numeric rating of 2.

What happens if I update the talent ratings on the career planning page?

The talent review process uses these ratings on a worker’s profile to build talent review information: talent score, performance rating, potential level, risk of loss, and impact of loss.

If you’re preparing for a talent review meeting and you update talent ratings, then the changes are reflected on the Prepare Content Review page. When the talent review meeting concludes, the application automatically updates workers’ Career Planning page with the final ratings for talent score, performance rating, potential level, risk of loss, and impact of loss. With the exception of the risk and impact of loss, all ratings from the talent review meeting are assigned a unique instance qualifier. The instance qualifier identifies them as those that resulted from the talent review meeting. If you then update these ratings on the Career Planning page, the talent review ratings remain in the database, but you can see your updates on the Career Planning page instead of the talent review ratings. You open the Career Planning page of a worker in the worker’s person spotlight.

Updating the career potential information also affects the performance-potential analytic in the performance management business process.

How can I prevent my manager from viewing job or position profiles in my interest list?

On your Career Planning page, click Edit, and select the Private check box for the job or position profile. To open your Career Planning page, select Navigator > Me > Career Planning.

Only you can view job and position profiles that are set to private. Anyone who can view your career planning page can view only those job and position profiles that aren’t set to private.
What's the difference between the suggestions list and the interest list?

The suggestions list is automatically generated for you each time you view your Career Planning page. To open your Career Planning page, select Navigator > Me > Career Planning. This list contains profiles of jobs or positions that are suitable for you. The suggested profiles are based on an analysis of how well your competencies, skills, and qualifications match those of the job or position profile.

You create the interest list by browsing profiles of jobs and positions and adding those that you might like to pursue. Your manager can also add job or position profiles to your interest list as suggestions for the next step in your career. You and your manager can also move profiles of jobs and positions from the suggestions list to the interest list.

Can I edit skills and qualification data of a person's profile?

Yes. Depending on the content section access settings for your role, you can view and edit any of the predefined or custom content of a worker's profile.

How can I add content to my profile?

Select Me > Skills and Qualifications on the Home page. Click Edit on the Skills and Qualifications page to edit or add the content to your profile. Depending on the content section access settings for your role, you can view and edit any of the predefined or custom content on your profile.

How can I hide an attribute on the person profile?

You must have the HR specialist role to hide an attribute on the person profile.

To hide an attribute on the person profile:

1. Click Manage Profile Types on the Tasks tab in the Profiles work area.
2. Search for the Person profile type and select the row for the profile type in the Search Results section.
3. Click Edit in the Search Results section to open the Edit Profile Type page.
4. On the Content Sections tab, select the content section that includes the attribute you want to hide.
5. In the Content Sections region, click the selected content section link to open the Content Section page.
6. In the Content Properties section, select None as the Display value for the attribute you want to hide.

How can I delete an attribute from the person profile?

You must have the HR specialist role to delete an attribute from the person profile.

✏️ Note: You can hide predefined attributes, but you can’t delete them.

To delete an attribute that isn’t a predefined attribute from the person profile:

1. Click Manage Profile Types on the Tasks tab in the Profiles work area.
2. Search for the Person profile type and select the row for the profile type in the Search Results section.
3. Click Edit in the Search Results section to open the Edit Profile Type page.
4. On the Content Sections tab, select the content section that includes the attribute you want to delete.
5. In the Content Sections region, click the selected content section link to open the Content Section page.
6. In the Content Properties section, select the row for the attribute and click Delete.

Modifying Talent Profiles

Modifying the Skills and Qualifications Page to View Talent Ratings: Procedure

By default, line managers can view or edit talent ratings for a report on the report’s Career Planning page. However, by using Oracle Page Composer, you can modify the Skills and Qualifications page of reports to display talent ratings on the Skills and Qualifications page and hide talent ratings on the Career Planning page. To change a page, you must have the privilege to modify pages. After making your changes, depending on their accessibility to a talent rating type, line managers can view or edit the talent rating type on a direct report’s Skills and Qualifications page. You manage the content section access settings of a talent rating type for a user role using the Manage Profile Types task. The task is available in the Setup and Maintenance, Profiles, or Person Management work area.

Note: You must use an active sandbox to modify the Skills and Qualifications page using Page Composer.

To display talent ratings on a direct report’s Skills and Qualifications page:

1. Sign in as a user who has the privilege to modify the Team Talent page.
2. Select My Team > My Team > Talent.
3. To open the Skills and Qualifications page of a direct report, click the direct report.
4. Click the user name and from the Settings and Actions menu, select Edit Pages.
5. On the Edit Pages dialog box, select the Edit option for the Site layer and click OK.
6. Select View > Source at the top-left section of the page to open the Source edit mode.

Tip: By default, the Source window is collapsed in the bottom position. To change the Source window position to the left, select View > Source Position > Left. To see the source content, you may need to drag the page splitter.

7. Click the Skills and Qualifications icon on the Skills and Qualifications page. The source tree moves to the corresponding region component.

Note: The location is displayed when you hover over a region component.

9. In the Component Properties: region dialog box, select the Display Options tab.
10. Select the Visible check box.
11. Click OK to close the dialog box. The Talent Ratings section appears on the Skills and Qualifications page.
12. Click Close to close Page Composer.
13. Publish your sandbox to make your changes available to users who are line managers.
To adjust the position of sections as they appear on the page, use Page Composer.

Related Topics

- Create and Activate Classic Sandboxes

Modifying the Grid View of the Team Talent Page to Display Talent Score and N Box Cell Assignment Ratings: Procedure

By default, line managers can’t view or edit talent score and n box cell assignment ratings for a report on the Team Talent page in the grid view. However, by using Oracle Page Composer, you can change the Team Talent page to display both the ratings in the grid view of the page. To change a page, you must have the privilege to modify pages. After changes have been made, depending on their accessibility to a talent rating type, line managers can view or edit the talent rating in the grid view of the Team Talent page. You can display only two ratings on a person card in the grid view of the Team Talent page. Therefore, to display talent score and n box cell assignment ratings, you must modify the existing ratings displayed in the grid view. You manage the content section access settings of a talent rating for a role using the Manage Profile Types task. The task is available in the Setup and Maintenance, Profiles, or Person Management work area.

Prerequisites

Activate a sandbox.

Modifying the Grid View

In the following procedure, the Performance rating is replaced with N Box Cell Assignment and the Potential rating with Talent Score.

To enable a line manager to view n box cell assignment and talent score ratings in the grid view of the Team Talent page:

1. Sign in as a user who has the privilege to access the Team Talent page.
2. Select Navigator > My Team > Team Talent. The Team Talent page appears in the grid view.

   Tip: If the grid view isn’t selected, click the View Grid icon.

3. Click your user name in the global area and from the Settings and Actions menu, select Edit Pages.

   Note: If the Confirm Task Flow Edit dialog box appears anytime during this procedure, click Edit to continue.

4. On the Edit Pages dialog box, select the Edit option for the Site layer and click OK.
5. Select View > Source at the top-left section of the page to open the Source edit mode.

   Tip: By default, the Dock pane is collapsed in the bottom position. To see the source content, you can drag the page splitter to the top.

6. Replace existing labels on the person card of the Team Talent page with N Box Cell Assignment and Talent Score:
   a. Click Performance on a person card on the Team Talent page. The source tree moves to the Performance component.
   b. Right-click the component and select Edit. The Component Properties dialog box appears.
c. In the **Value** field, click the drop-down button and select **Select Text Resource**. The **Select Text Resource** dialog box appears.
d. In the **Key** field enter a unique value. For example, NB1. You use this value to reuse the label in other pages
e. In the **Display Value** field, enter the label for the n box cell assignment rating. For example, N Box Cell Assignment.
f. Click **OK**.
g. Click **Apply** and then **OK** to close the **Component Properties** dialog box.
h. Repeat steps 6.1 through 6.8 to change the label Potential as Talent Score on the person card on the Team Talent page. For Talent Score, you can enter values for the **Key** and **Display Value** fields as shown in the following table.

<table>
<thead>
<tr>
<th>Field</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>TS1</td>
</tr>
<tr>
<td>Display Value</td>
<td>Talent Score</td>
</tr>
</tbody>
</table>

7. Use the expression language (EL) to display the value of the n box cell assignment and talent score ratings below the edited labels:
   a. In the source tree, select the **outputText** node below the **outputText: N Box Cell Assignment** node.
   b. Right-click the component and select **Edit**. The **Component Properties** dialog box appears.
   c. In the **Value** field, click the **Edit** icon and select **Expression Builder**. The **Edit** dialog box appears.
   d. In the **Type a value or expression** field, enter the **#{row.NBoxAssignment}** expression.
   e. Click **OK**.
   f. Click **Apply** and then **OK** to close the **Component Properties** dialog box.
   g. In the source tree, select the **outputText** node below the **outputText: Talent Score** node.
   h. Repeat steps 7.2 through 7.6 to enter the **#{row.TalentScore}** expression for the talent score rating.

8. Click **Close** to close Page Composer.
9. Publish your sandbox to make your changes available to users who are line managers.

**Related Topics**
- Create and Activate Classic Sandboxes

**Modifying the List View of the Team Talent Page to Display Talent Score and N Box Cell Assignment Ratings: Procedure**

By default, line managers can’t view or edit a report’s talent score and n box cell assignment ratings on the Team Talent page in the list view. However, by using Oracle Page Composer, you can modify the Team Talent page to display both the ratings in the list view of the page. After you make changes, depending on their accessibility to a talent rating type, line managers can view or edit the talent rating in the list view of the Team Talent page. You manage the content section access settings of a talent rating for a user role using the Manage Profile Types task. The task is available in the Setup and Maintenance, Profiles, or Person Management work area.

**Prerequisites**
Activate a sandbox.
Modifying the List View

To enable line managers to view n box cell assignment and talent score ratings in the list view of the Team Talent page:

1. Sign in as a user who has the privilege to access the Team Talent page.
2. Select Navigator > My Team > Team Talent. The Team Talent page appears in the grid view.
3. Click the View List icon.
4. Click your user name in the global area and from the Settings and Actions menu, select Edit Pages.

Note: If the Confirm Task Flow Edit dialog box appears anytime during this procedure, click Edit to continue.

5. On the Edit Pages dialog box, select the Edit option for the Site layer and click OK.
6. Select View > Source at the top-left section of the page to open the Source edit mode.

Tip: By default, the Dock pane is collapsed in the bottom position. To see the source content, you can drag the page splitter to the top.

7. On the Team Talent page, click Potential or any other talent rating. The source tree moves to the corresponding rating component.
8. Under the panelGroupLayout: vertical component for the panelStretchLayout node, select the disabled node panelLabelAndMessage:N Box Cell Assignment and right-click.
10. On the Display Options tab, select the Visible check box and click Apply.
11. Click OK to close the dialog box.
12. Under the panelGroupLayout: vertical component for the panelStretchLayout node, select the disabled node panelLabelAndMessage:Talent Score.
13. Click Edit. The Component Properties: Talent Score dialog box appears.
14. On the Display Options tab, select the Visible check box and click Apply.
15. Click OK to close the dialog box.
16. Click Close to close Page Composer.
17. Publish your sandbox to make your changes available to users who are line managers.

Related Topics

- Create and Activate Classic Sandboxes
3 Goal Management

Manage Performance Goals: Overview

Managers and workers can manage the performance goals. Workers can also mark performance goals that they create as private. Private goals aren’t visible to others. To manage performance goals, start on the My Goals page in the Goals work area.

Workers and managers can:

- Add performance goals and update them throughout the review cycle.
- Update worker person profiles by adding target outcomes to goals.
- Add and update tasks to provide specific actions that determine how workers can achieve their goals.
- Share their performance goals with direct reports or others to make goals available to copy.
- Assign their performance goals to direct reports.
- Align their performance goals to published organization goals in addition to goals shared by managers and colleagues.
- Copy a goal and change the goal plan and attributes of the new copied goal as appropriate. The copied goal is added to the worker’s goals list.
- Move a goal to another goal plan. The moved goal is no longer associated with the source goal plan.
- Extend a goal to another goal plan to let the worker continue working on the goal for a period later than the current goal plan. The target goal plan must have an end date later than the end date of the current goal plan. After extending, the goal is associated with both the source and target goal plans. Any subsequent changes to the goal in the source goal plan are also carried onto the target goal plan after you extend the goal.
- Track measurements added to goals.

Related Topics

- Goal Management: Explained
- Making Performance Goals Available to Workers: Points to Consider

Managing Your Goals

Video

Watch: In this video tutorial, you will learn how to review your goals and goal alignment within your organization and update goal progress and mark them as complete. The content of this video is also covered in text topics.
Worked Example

This example shows how to track your goals progress, edit details of an existing goal, view goal alignment within your organization, and share a goal with your direct reports.

The following table summarizes key decisions for this scenario.

<table>
<thead>
<tr>
<th>Decisions to Consider</th>
<th>This Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Which review period is associated with my goals?</td>
<td>2015 Annual Cycle</td>
</tr>
<tr>
<td>Which goal plan is associated with the review period that includes my goals?</td>
<td>2015 Performance Goals</td>
</tr>
<tr>
<td>What are the goals assigned to me?</td>
<td>The following goals are assigned to you:</td>
</tr>
<tr>
<td></td>
<td>• Developing the team</td>
</tr>
<tr>
<td></td>
<td>• Increase Shareholder Value</td>
</tr>
<tr>
<td></td>
<td>• Bring Customer Satisfaction Levels to 90%</td>
</tr>
<tr>
<td></td>
<td>• Complete Business Ethics Course</td>
</tr>
</tbody>
</table>

Summary of the Tasks

Manage your goals by:

1. Viewing your goals
2. Editing details of an existing goal
3. Viewing the goal alignment chart
4. Sharing the goal

Viewing Your Goals

1. In the Goals work area, click the My Goals tab.
2. From the review periods list on the My Goals page, select 2015 Annual Cycle.
3. In the Goal Plan list, select 2015 Performance Goals. On the My Goals page, you can view and update the priority, weight, and your progress for each goal included in the 2015 Performance Goals goal plan.
4. To update the progress of the goal Bring Customer Satisfaction Levels to 90%, click the graph for the progress indicator. The Update Goal Status dialog box opens.
5. Update the progress to 50% and click Save.

Editing Your Goals

You can edit goals that are assigned to you.

1. To edit your goal Bring Customer Satisfaction Levels to 90%, on the My Goals page, click the goal name.
2. On the Edit Goal page, you can view goal details such as its name, start date, description, and success criteria. in addition, you can view measurements, target outcomes, and tasks for the goal. Edit the following properties of the goal on the Goal Details tab as shown in the following table.
### Goal Management

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Category</td>
<td>Customer satisfaction</td>
</tr>
<tr>
<td>Level</td>
<td>Target</td>
</tr>
<tr>
<td>Description</td>
<td>Improve overall customer satisfaction to 90% based on customer surveys during the evaluation period.</td>
</tr>
</tbody>
</table>

3. Click **Save and Close** to save changes to the goal.

### Viewing the Goal Alignment Chart

If a goal is aligned to other goals or other goals aligned to the goal, you can view the goal alignment chart for the goal.

1. On the My Goals page, click the goal alignment icon for the goal Developing the team.
2. On the Goal Alignment: Developing the team page, you can view the alignment chart of the goal Developing the team. You can move the chart to see how your goal aligns to the organization goal and other goals are aligned to your goal. You can also view the progress of the your goal.

### Sharing Your Goals

You can share your goals.

1. On the My Goals page, click the Actions menu for a goal and select **Share**.
2. On the Share Goal page, you can select whom to share the goal with. As a manager, you can share the goal with the whole team. Click **Add** and select **Direct Reports**. You can delete a report that the goal many not pertain to or you can add other workers too.
3. Click **Save and Close**. The goal is shared with selected workers and the shared icon appears for the goal on the My Goals page.
4. Click the shared icon for the goal to see with who you have shared the goal.

### Administer Goals

#### Administering Performance Goals: Explained

Administer organization goals, worker goals, worker goal plans, and worker goal plans that are pending approval from the Administer Goals page. Depending on your role and security privileges, you can access the Administer Goals page. To access the page, in the Goals work area, select the Tasks tab, and then in the Related Links panel, click **Administer Goals**.

#### Administering Organization Goals

To administer organization goals, select **Organization Goals** on the Administer Goals page.

Using this option, you can perform the following actions:

- Update existing organization goals: You can search for and edit, cancel, or delete organization goals for an organization owner.
- Transfer organization goals: You can transfer organization goals from one organization owner to another.
• Upload and assign organization goals using a spreadsheet: You can upload new organization goals using an application-generated spreadsheet and assign them to workers.

• Export organization goals: You can search for organization goals assigned to a department and export them to an excel workbook to view or analyze exported data. The workbook includes only those columns that were displayed on the UI.

Administering Worker Goals
To administer worker goals, select **Worker Goals** on the Administer Goals page.

Using this option, you can perform the following actions:

• Copy, move, cancel, or delete a worker goal: You can search for and copy, move, cancel, or delete goals for a worker.

• Update existing worker goals: You can search for and click the goal name in the search results to open the edit goal page for goals that aren’t completed or view goals page for goals that were completed.

• View worker goals summary: You can click a worker name in the search results to view the summary of goals assigned to the worker.

• Upload goals, tasks, and measurements using a spreadsheet: You can download an application-generated spreadsheet to upload or update worker goals, and tasks and measurements associated with worker goals.

• Export goals of a worker to an excel workbook: You can search for goals assigned to a worker and export them to an excel workbook to view or analyze exported data. The workbook includes only those columns that were displayed on the UI.

Administering Worker Goal Plan Sets
To administer worker goal plan sets, select **Worker Goal Plan Sets** on the Administer Goals page.

Using this option, you can perform the following actions:

• Change dates: You can change the effective dates of goal plan sets for a worker. For example, to resolve conflicts in dates for goal plan sets because of a worker’s transfer.

• Set to active or pending: You can change the status of an active goal plan set to pending and pending to active. Goal plan sets with the status pending aren’t displayed on application pages.

• Change goal plan weights: You can search for and click a goal plan set in the search results and change the weight of goal plans in a goal plan set for a worker.

• Export goal plan sets to an excel workbook: You can search for goal plan sets assigned to a worker and export them to an excel workbook to view or analyze exported data. The workbook includes only those columns that were displayed on the UI.

Administering Pending Goal Plans
To administer pending goal plans, select **Pending Goal Plans** on the Administer Goals page.

Using this option, you can perform the following actions:

• Search for worker goal plans pending approval: You can search for goal plans pending approval and review information about related approval requests for goal changes including the action type and transaction ID.

• Complete approval transactions: You can approve or reject pending approval transactions for goal plans. Any actions performed for an approval request on the Administer Goals page bypass any other approval workflows and notifications.
Note: You must use Oracle Page Composer to enable approval buttons on the Administer Goals page for the Pending Goal Plans option.

- Export pending goal plans to an excel workbook: You can search for goal plans pending approval and export them to an excel workbook to view or analyze exported data. The workbook includes only those columns that were displayed on the UI.

Related Topics

- Uploading Worker Goals, Measurements, and Tasks Using a Spreadsheet: Explained
- Uploading and Assigning Organization Goals Using a Spreadsheet: Explained
- Changing the Weight of a Goal Plan in a Goal Plan Set: Procedure
- Changing Effective Dates of Goal Plan Sets: Examples

Modifying the Administer Goals Page in Goal Management: Procedure

To perform an approval action on the Administer Goals page in the Goal Management work area, you must enable the approval action buttons on the page. Use Oracle Page Composer to enable the approval action buttons, Approve and Reject, on the Administer Goals page.

Note: You must use an active sandbox to modify the Administer Goals page using Oracle Page Composer.

To display the Approve and Reject buttons on the Administer Goals page:

1. Sign in as an HR specialist.
2. Select Navigator > My Client Groups > Goals.
3. In the Related Links panel on the Tasks tab, click Administer Goals.
5. Click the user name, and from the Settings and Actions menu select Administration >Edit Pages.
6. Select the Edit option for the Site layer and click OK.
7. Select the Select option at the top-left section of the page.
8. In the Search Results section, click the empty component next to the Format menu. A box appears.
9. Click Edit Parent Component in the box to open the Component Properties group dialog box.
10. Select the Child Components tab.
11. Select Reject and Approve.

Tip: You can adjust the position of buttons as they appear on the page.

12. Click Apply, and then click OK to close the dialog box. The Approve and Reject buttons appear on the page.
13. Click Close at the page level to close Oracle Page Composer and view the page. You can now use the Approve and Reject buttons for approving goal plans that appear in the search results.

Related Topics

- Create and Activate Classic Sandboxes
Performance Goal Measurements: Explained

Workers can add measurements to assess the level of success of achieving a goal. Managers can add and assign measurements to goals of their reports so that they can assess the success of a worker toward achieving a goal.

About Creating Single Measurements for Goals

You can select and define a single measurement for a goal. You define and view a measurement for a goal in the Measurement section. If you select a unit of measure (UOM), you can include optional data for the measurement, such as target type, target value, and actual value. To access the section, click the Measurements link on the add or edit goal pages.

About Creating Multiple Measurements for Goals

Enable multiple measurements for goals using a profile option. When the profile option is enabled, you can define and view multiple measurements for a goal. If you select a UOM, you can include optional data for the measurement, such as target type, target value, and actual value. In the Measurements section, you can drag and drop measurements to change their display order in the section and in OTBI reports.

Calculation Rules for Multiple Measurements

Select a calculation rule when multiple measurements have the same UOM on the add or edit goal pages. The calculation rule you select is used to determine the overall target and actual values for a goal. The options are:

- **Average**: The average of the actual and target values is the overall actual and target values for a goal.
- **Sum**: The sum of the actual and target values is the overall actual and target values for a goal.

Related Topics

- Goal Management: Explained

Goal Actions

Aligning Performance Goals: Explained

You align performance goals to create a relationship between a worker’s goal and a higher-level goal, such as an organization or manager goal. This relationship enables the worker’s goal to support and contribute to achieve the higher-level goal. You can align one of your goals to only one other goal; both goals must be associated with the same review period.

Goals can also be aligned to those of colleagues to support peers’ goals if they are within the same review period. This allows workers on informal teams or groups working across different reporting groups to show a relationship between each other. For the owner of the goal to which others are aligned, it’s a way to determine how many people are working for the goal, for example, for a specific project or initiative. You can’t align private goals to another goal or have other goals aligned to them.
Goal alignment provides the flexibility to:

- Align goals automatically.
- Modify supporting goals.
- Remove alignment.

**Aligning Goals Automatically**

If organization owners assign organization goals to workers, or managers assign their own goals to workers, then the assigned goals are copies of the source organization or manager goal. These assigned goals are automatically aligned to the source goal. Goals that workers or managers add from either an organization goal, or a goal shared by a manager or colleague, are also automatically aligned to the organization or shared source goal.

If a goal is aligned to a goal, the goal alignment icon appears next to both the source goal and aligned goal on the Goals page. You can click this icon to open the Goal Alignment page and view the goal alignment hierarchy of the selected goal.

**Modifying Supporting Goals**

Supporting goals can be identical to the source goal, perhaps with different targets, or they can be completely different. Worker and managers can modify the attributes of the supporting worker goal.

**Removing Alignment**

Managers, workers, and HR specialists can remove alignment from one goal to another. Deleting a goal that is aligned to another goal removes the alignment between the goals. The goal that isn’t deleted isn’t affected, and you can align the remaining goal to another goal. If you cancel an organization goal, its alignment to other goals is also removed.

**Related Topics**

- Managing Organization Goals: Explained
- Cascading Performance Goals to Promote Strategic Alignment Throughout an Organization: Example

**Sharing Performance Goals: Explained**

Managers and workers can share performance goals so that others can add a copy of the shared goal to their goals list or align their own goals to the shared goal. For example, a manager might want a worker to know about the goals for overseas assignment but would like the worker to decide whether or not to add the goals. You can share goals by selecting the Share action for a goal on the My Goals page.

Managers can share their goals with either their direct reports, dotted-line reports, or selected persons. Workers can share their goals with the colleagues they select. Tasks that are associated with goals can also be shared. An email notification is sent to the people with whom the goal is shared.

Goals that are shared by managers appear as **Manager shared goals**. Those shared by colleagues appear as **Colleague shared goals**. Shared goals appear

- In the Goals Shared with Me section on the My Goals page.
- On the Source menu on the Add Goal from Other Sources and Align Goal pages. To view the Add Goal from other Source page, on the My Goals page, click **Add Goal > Other Sources**. To view the Align Goal page, on the My Goals page, select the Align action for a goal.
Shared Attributes

The following attributes of the original goal are shared with the recipient:

- Goal name
- Goal details including start date, target completion date, category, level, and description
- Measurement attributes including name, unit of measure, target type, and target value
- Target outcome attributes including name, description, and source
- Tasks attributes including name, type, priority, start date, and related link

Note: Profile options determine if you can add target outcomes and tasks to a goal. You set up profile options in the Setup and Maintenance work area. Goal plan settings determine which key goal fields of an added goal you can change. When you share a goal, you can decide further whether to share tasks, if enabled.

Updating and Aligning Shared Goals

Workers can update a goal added from a shared goal to change the goal name and dates, and add target outcomes and tasks. If the worker adds a goal shared by a manager, the new goal aligns automatically to the manager’s goal, so that the added goal supports the original goal. Adding and aligning don’t change the original goal.

Sharing Goals when a Worker or Manager Transfers

When a worker or manager transfers and that worker is no longer a direct report of the manager, the goal is still available to the worker and appears as the Colleagues’ Shared Goals under the Source menu of the Add Goal: Other Source and Align Goal pages.

Related Topics
- Making Performance Goals Available to Workers: Points to Consider
- Goal Plans: Explained
- Goal Management Profile Options

Mass Approve Goals

Mass Approve Goals Process: Explained

Using the mass approve goal process, workers can submit approval requests for multiple goals associated with a goal plan in a single transaction. They can use the Submit for Approval button on their My Goals page to submit goal changes for approval. Managers can then complete the approval process in a single transaction for all goal changes within a goal plan from the worker’s Goals page. They can use the Approve Goals button on the worker’s Goals page to review goal changes and complete approval requests. Managers can also use the Worklist for goal approvals.

HR specialists and implementors can use profile options to enable approvals for any combination of add, update, complete, cancel, and delete goal requests. Set the value of a profile option using the Manage Worker Goal Setting Profile Option Values task in the Setup and Maintenance work area. You can also use the Manage Administrator Profile Values task to set the value of a profile option.
Submitting Goal Changes for Approval

As a worker, you can submit all goal changes for a goal plan within a review period. Click the Submit for Approval button on the My Goals page in the Goals work area to submit all of your goal changes for approval. The button appears on the page for a goal plan only when you perform an approval-enabled action on a goal within the goal plan.

Before you submit goal changes within a goal plan for approval, you can:

- Perform any add, cancel, delete, update, or complete action on goals.
- Undo any changes to a goal.
- Delete a new goal that you added before submitting the goal for approval.

Managers can’t view the goal changes on your Goals page, until you submit the goal plan for approval.

After the goal plan with all goal changes is submitted for approval, the goal plan appears as read-only on the Goals page. Once submitted, and until the approval process is complete:

- The goals and the associated goal plan appear as read-only on the worker’s Goals page, in both the manager and worker views.
- The value of goal attributes submitted for approval appears on the worker’s Goals page. Manager can also view changes to the goal on the worker’s Goals page.

When the approval process completes, the value of goal attributes is updated based on the approval action.

Taking Approval Actions

As a manager, you can approve or reject all goal changes for a goal plan in a single action. Click the Approve Goals button on the worker’s Goals page to approve or reject goal changes. The button appears on the page for a goal plan only when the approval is enabled and the goal plan was submitted for approval. You can also use the Worklist to approve or reject goal changes.

Approving goals from the worker’s Goals page provides:

- A complete view of the worker’s goal plan
- A list of all goal changes in a goal plan

Approval Actions Results

The following table lists the approval actions taken by a manager on worker goal approval requests and their results.

<table>
<thead>
<tr>
<th>Approval Action</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Approve goal changes</td>
<td>• The read-only access is removed for the worker’s goal and the goal plan.</td>
</tr>
<tr>
<td></td>
<td>• The worker can continue working on the goal with the updated value of goal attributes.</td>
</tr>
<tr>
<td></td>
<td>• Any deleted goal is removed from the Goals pages.</td>
</tr>
<tr>
<td>Reject goal changes</td>
<td>• The read-only access is removed for the worker’s goal and the goal plan.</td>
</tr>
<tr>
<td></td>
<td>• The updated value of goal attributes submitted for approval still appears for the goal. The worker can undo the changes to revert to the previously approved version of the goal and continue working on the goal.</td>
</tr>
<tr>
<td></td>
<td>• The worker can still view the new goal submitted for approval on the My Goals page. The worker can make changes to the new goal or delete it.</td>
</tr>
</tbody>
</table>

*Note:* Any further updates to a goal must be again submitted for approval, if enabled.
FAQs for Goal Management

Can I update my performance goal after I have submitted it for approval?

All goals submitted for approvals are read-only until the related goal plans are approved. When you submit a goal for approval, you also submit the goal plan to which the goal is added for approval for all goal plan changes. All goals in the goal plan are read-only until the approval request is completed.

How can I update or track progress toward performance goal completion?

Click the link to the goal on the My Goals page at any time throughout the goal plan period to record the completion percentage as you progress toward finishing it, or to make any other updates. Alternatively, click the visual gauge indicating goal progress for the goal on the My Goals page to open the Update Goal Status dialog box and enter the progress details.

How can I complete a performance goal?

Open the My Goals page in the Goals work area, and click the link to the goal that you want to complete. Then click Goal Details on the edit page of the goal, and update the status of the goal to Completed. Alternatively, click the visual gauge indicating goal progress for the goal on the My Goals page to open the Update Goal Status dialog box, and update the status to Completed. After you change the status, you can also enter the actual completion date of the goal. If you require manager approval, you must gain final approval for completing the goal.

What happens if I align a performance goal?

When you align a performance goal to a higher-level source goal, you create a relationship between the two that indicates that the aligned goal supports the source goal. Source goals are either organization goals or goals assigned or shared by managers or the colleagues of a worker. However, the worker’s goal is independent; workers can update or modify their goals as needed, or remove the alignment.
What happens if I share a performance goal?

A shared performance goal is available to others so that they can add it to their own list of goals or align their own goals to it, when alignment is configured. The goal you share belongs to only you and can't be changed by the people with whom you shared it.

What's a target outcome?

Target outcomes are specific skills, competencies, or certifications added to a goal that can be achieved or acquired by the successful completion of the goal. Target outcomes help workers improve their proficiency at their current jobs or develop additional qualifications to prepare them for future jobs. The availability of target outcomes for addition to goals depends on the content section access settings for your role.

Why can't I update my goal plan?

You can't update goal plans that are pending approval. If approval is required, any goal or goal plan changes you make aren't final until approval is granted for the associated goal plan.

Why do I have performance goals assigned to me before I have added any?

Goals in your list of performance goals may have been assigned by a manager, the organization, or the HR specialist. You can't cancel or delete goals that are assigned to you. Incomplete goals may also have been copied from previous goal plans when the HR specialist creates your current goal plan. Incomplete goals are those with the status of Not started or In progress.
Review Periods in Talent Management: Explained

Review periods are business periods that you use to link Oracle Fusion Talent Management business objects to measure and achieve results within the review period time line. Review periods enable you to organize your processes around goal management and performance evaluations into time bound business cycles. Review period is a common component that ties to goal plans and performance document periods. For example, you can connect an employee’s performance to business objectives and results by associating goal plans in the Goals work area and performance documents in the Performance Management work area with business periods using review periods.

Managing Review Periods

As an HR specialist, you create and manage review periods by using the Manage Review Periods task. You can open the task:

- In the Related Links panel on the Tasks tab in the Goals work area
- On the Tasks tab on the My Evaluations page in the Performance work area
- In the Setup and Maintenance work area

Each review period must have a unique name. You can create review periods any time, and later associate them with goal plans, goal plan sets (if enabled), and performance documents. If a review period is in use by a business object, then you can’t modify the start and end dates of the review period. The application also adds the tag In Use to the review period next to the Status attribute on the Edit Review Period page. If the review period isn’t used by any business objects, the application adds the tag Not in Use.

You can set the review period status to active or inactive any time. The business objects already associated with an inactive review period will still use the review period. Inactive review periods are no longer visible to HR specialists when creating a business object, such as a goal plan, goal plan set, or performance document. Workers can’t view inactive review periods on the application pages.

Associating Goal Plans, Goal Plan Sets, and Performance Documents with Review Periods

You create review periods to associate with goal plans and performance documents that fall within the review period dates. In the performance template, you select the review period to associate with a performance period from which the performance document is created. This enables you to connect an employee’s performance evaluation with the progress on a performance goal in a goal plan within a business cycle. If goal plan sets are enabled, you must also associate review period with sets within the review period time frame, thereby, associating all goal plans within a goal plan set with the selected review period.

Related Topics

- Goal Plans: Explained
- Goal Plan Sets: Explained
- Performance Documents: How They Work with Goals
5 Organization Goals

Assigning Organization Goals: Explained

An organization goal specifies the overall objectives of the organization. HR specialists assign existing organization goals to workers by using the Mass Assign Goals task or an application-generated spreadsheet. To add new organization goals, the organization goal plan must be assigned to your organization. You can then add goals to your organization goal plan, and then assign or publish these organization goals to your reports. Workers can add published organization goals to their goal plans on the My Goals page.

Organization Goals Assigned by HR Specialists

HR specialists assign existing organization goals to workers by using the following options:

- Mass Assign Goals task: Use the Mass assign Goals task to search for existing organization goals and mass assign them. To open the Mass Assign Goals page:
  
a. Select Navigator > My Workforce > Goals.
  b. In the Related Links panel on the Tasks tab, click Mass Assign Goals. The Mass Assign Goals page is displayed.

- Application-generated spreadsheet: Use the application-generated spreadsheet to assign existing organization goals to workers. To generate the spreadsheet:
  
a. Click Administer Goals in the Related Links panel on the My Goals page in the Goals work area.
  b. On the Administer Goals page, select Organization Goals to open the Organization Goals section.
  c. Click Upload and select the Upload Organization Goals action. A dialog box to download the file appears.
  d. Click Save. Select a destination on your local hard disk to save the OrganizationGoalsWorksheet.xlsx spreadsheet.

The organization goals assigned by HR specialists:

- Appear in the goals list for workers on their My Goals page
- Show HR specialist as the Source on the Goal Details tab on the Edit Goal page
- Aren’t aligned to any goals
- Are associated automatically with a goal plan assigned to the worker. The associated goal plan duration spans the organization goal start and target completion dates

Note:

- If there is no worker goal plan that spans the organization goal duration, the goal isn’t assigned to the worker.
- If there is more than one goal plan that spans the organization goal duration, the goal is associated with the goal plan with the latest start date.
Organization Goals Assigned by Managers

HR specialists assign organization goal plans to departments on the Manage Goal Plans page. Line managers or executive managers of those departments can then add organization goals to the goal plan on the My Organization Goals page. They can then assign those goals to their supervisor hierarchy. By default, individuals with the Line Manager or Executive Manager roles can manage organization goals.

The organization goals assigned by line managers:

- Appear in the goals list for workers on their My Goals page
- Show Manager as the Source on the Goal Details tab on the Edit Goal page
- Align automatically to the manager’s organization goal. The goal alignment icon appears next to both the assigned goal and original organization goal on goal pages
- Associate automatically with a goal plan assigned to the worker. The associated goal plan duration spans the organization goal start and target completion dates

**Note:**
- If there is no worker goal plan that spans the organization goal duration, the goal isn’t assigned to the worker.
- If there is more than one goal plan that spans the organization goal duration, the goal is associated with the goal plan with the latest start date.

**Related Topics**
- Creating a Request for Mass Assignment of Performance Goals: Points to Consider
- Creating Goal Plans: Points to Consider

Managing Organization Goals: Explained

An organization goal specifies the overall objectives of the organization. Organization owners are managers who manage organization goals. You must have an organization goal plan to manage organization goals. HR specialists assign organization goal plans to organization owners. Then organization owners publish or assign their organization goals to their organization. You must have either the line manager or the executive manager role to manage organization goals. As a manager, you can manage only those organization goals that you created or added to the goal plan. You manage organization goals from the My Organization Goals page in the Goals work area.

Throughout the goal period organization owners can perform the following actions on organization goals:

- Add, update, cancel, and delete
- Move
- Publish
- Assign
- Align
Add, Update, Cancel and Delete

When an organization goal plan is assigned to you, you can add goals that you have created yourself or from the goal library to the goal plan. You can also add measurements and tasks, if enabled, to a goal. However, you can’t add target outcomes to an organization goal.

When you delete a goal, the application removes the goal completely and you can’t recover it. Canceled goals are still visible, but you can’t assign, publish, move, or align them.

If you delete or cancel an organization goal, you remove the alignment between it and any goals that were aligned to it.

Publish

Publish organization goals to make them available to everyone in your supervisor hierarchy. Workers can add published goals to their own goal plans. They can edit goal attributes to make them suitable for their own job responsibilities.

When you publish an organization goal, the goal is listed in the following locations:

- **Other Sources** option displayed on the Add Goal menu on the goal pages for your reports
- Goals Shared with Me section on the My Goals page of your reports

After you publish a goal, your reports receive a notification about the published goal in their Worklist.

Assign

Organization owners can assign organization goals from the My Organization Goals page:

- Direct reports
- Indirect reports
- Selected individuals
- Direct and indirect reports of selected individuals

They can determine whether to enable workers to update key attributes of the goal, such as goal name, target completion date, and so forth.

When you assign an organization goal from the My Organization Goals page, a copy of the organization goal is assigned to the worker. The assigned worker goal is aligned automatically to the original organization goal. The assigned goal is available on the My Goals page to the worker and the goal alignment icon appears next to both the assigned goal and original organization goal on goal pages. The assigned goal is associated automatically with an existing goal plan assigned to the worker. The associated goal plan duration spans the organization goal start and target completion dates.

**Note:**

- If there is no worker goal plan that spans the organization goal duration, the goal isn’t assigned to the worker.
- If there is more than one goal plan that spans the organization goal duration, the goal is associated with the goal plan with the latest start date.

Align

Workers can align their goals to your published organization goals to ensure that there is a direct relationship between their individual objectives and those of your organization. As a manager, you can also align any goals of your direct reports to a published organization goal. Both the worker goal and organization goal must be associated with the same review period. The goal plan associated with worker goals can be different than that of the aligned organization goal. You can also align
organization goals to another organization goal within the same review period. You can click the goal alignment icon to view the alignment hierarchy for the goal.

If a goal is aligned to an organization goal, the goal alignment icon appears next to both the worker goal and aligned organization goal on goal pages. Click this icon to open the Goal Alignment page and view the goal alignment hierarchy of the selected goal. The Goal Alignment page shows how goals can cascade from an organization or individual manager to every level of the organization.

Related Topics

- Aligning Performance Goals: Explained

Cascading Performance Goals to Promote Strategic Alignment Throughout an Organization: Example

This example uses a four-level organization to show how performance goals can cascade from an organization, or individual manager, to every level of the organization. Using the cascading process, goals assigned to workers at the entry-level of an organization hierarchy support a higher-level organization goal. The worker goals and organization goal must be associated with the same review period.

In this example:

- HR specialists have security privileges to access the Manage Goal Plans page.
- Managers have security privileges to access the My Team Goals page.
- Workers have security privileges to access the My Goals page.

Scenario

The top manager of your southern sales organization, John, wants to boost sales in your company’s southern area. John decides that setting specific performance goals throughout the organization best addresses the sales objectives for the company and meet the sales targets. The entire organization is assigned the review period "FY 2018 Review Period."

Cascading Goals Throughout the Sales Organization

To allocate the enterprise performance goals in some form to all workers in an organization, you can assign the goals by using the cascading process. The goals that you assign to your organization and the organization goal must all be associated with the same review period. In this example, the four levels of the southern area include the following positions:

- Sales manager
- Store manager
- Department manager
- Sales assistant
John’s organization has the goal “Develop Customer Awareness,” based on the enterprise objectives. The HR specialist assigned an organization goal plan, “John's Organization,” to John. The goal plan is associated with the review period “FY 2018 Review Period.”
Analysis

To begin, John does the tasks as described in the following table.

<table>
<thead>
<tr>
<th>Who</th>
<th>What</th>
<th>Where</th>
</tr>
</thead>
<tbody>
<tr>
<td>John</td>
<td>1. Adds the goal &quot;Develop Customer Awareness&quot; to the organization goal plan &quot;John’s Organization&quot; associated with the review period &quot;FY 2018 Review Period&quot;</td>
<td>My Organization Goals page</td>
</tr>
<tr>
<td></td>
<td>2. Publishes the goal so that John’s direct reports can see the top organization level (southern area) goal. The goal is available to direct reports to add from other sources and is associated with the review period &quot;FY 2018 Review Period&quot;</td>
<td></td>
</tr>
<tr>
<td>John</td>
<td>Adds the goal:</td>
<td>My Team Goals page or report’s Goals page</td>
</tr>
<tr>
<td></td>
<td>• &quot;Conduct Customer Survey&quot; to Alex by associating the goal with a goal plan assigned to Alex. The goal plan must be associated with the review period &quot;FY 2018 Review Period&quot;</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• &quot;Devise Customer Loyalty Scheme&quot; to Beth by associating the goal with a goal plan assigned to Beth. The goal plan must be associated with the review period &quot;FY 2018 Review Period&quot;</td>
<td></td>
</tr>
<tr>
<td>John</td>
<td>Aligns both the added goals to the organization goal &quot;Develop Customer Awareness&quot;</td>
<td>Report’s Goals page</td>
</tr>
</tbody>
</table>

After John finishes, Alex and Beth see that they have goals assigned that align with John’s organization goal. They can use the My Team Goals page to assign the department level goals to their direct reports, the department managers. The following table shows the goals that Alex assigns to his department managers. All these goals are associated with the review period "FY 2018 Review Period."

<table>
<thead>
<tr>
<th>Department Manager</th>
<th>Goal</th>
</tr>
</thead>
<tbody>
<tr>
<td>Margaret</td>
<td>Devise Customer Questionnaire</td>
</tr>
<tr>
<td>Rohini</td>
<td>Plan Customer Award Event</td>
</tr>
<tr>
<td>Vijay</td>
<td>Conduct in Store Poll</td>
</tr>
</tbody>
</table>
Margaret, Rohini, and Vijay can align their individual goals to their manager Alex’s goal, "Conduct Customer Survey." They can then use the My Team Goals page to assign individual goals to their direct reports. In this example, Margaret can assign goals to her direct reports Ted, Michael, and Donna. She can then align her reports’ goals with her own goal, "Devise Customer Questionnaire."

**Resulting Supporting Goals**

The cascading process defines goals for all levels of John’s organization. Each level comprises goals that support and align with the goals at the next level above. John and all of the line managers can track the overall progress on the organization goals using the My Organization Goals page.

This figure shows the cascaded goals that support the “Develop Customer Awareness" goal for the southern area from our example.
Related Topics

- Making Performance Goals Available to Workers: Points to Consider
- Aligning Performance Goals: Explained

FAQs for Organization Goals

How can I prevent line managers from accessing organization goals?

By default, individuals with the Line Manager role have access to organization goals. To prevent line managers from managing organization goals, the IT security manager must remove the Goal Management Organization Owner Duty role from the Line Manager role. You can restrict the access to organization goals by assigning the Executive Manager role to selected line managers and individuals enabling them to manage organization goals.

Can I select individuals to manage organization goals?

By default, individuals with the Line Manager role or the Executive Manager role can manage organization goals. You can restrict access to organization goals to selected individuals by assigning the Executive Manager role to them.

What's an organization goal?

A performance goal that specifies the overall objectives of the organization. Organization owners can assign the performance goal to organizations of type department only. They enable workers to copy the goal and align their own goals to it to achieve the same overall business objective.

How can I transfer organization goals from one organization owner to another?

The HR specialist can transfer organization goals from one organization owner to another on the Administer Goals page by selecting organization goals and clicking Transfer.
6 Spreadsheets for Uploading Goals

Uploading Worker Goals, Measurements, and Tasks Using a Spreadsheet: Explained

Using an application-generated spreadsheet, you can:

- Upload and assign worker performance and development goals.
- Add measurements and tasks to worker goals.
- Update existing goals assigned to workers.
- Update existing measurements and tasks.

Use the Worker Goals option on the Administer Goals page to download the spreadsheet.

The application-generated spreadsheet for worker goals contains the following three worksheets:

- Update Worker Goals: Use this worksheet to upload new or update existing worker performance or development goals.
  
  **Note:**
  - Performance goals are updated in Goal Management and development goals are updated in Career Development.

- Update Measurements: Use this worksheet to upload new or update existing measurements associated with worker goals, performance or development. Measurements associated with performance goals are updated in Goal Management. Measurements associated with development goals are updated in Career Development.

- Update Tasks: Use this worksheet to upload new and update existing tasks associated with worker goals, performance or development. Tasks associated with performance goals are updated in Goal Management. Tasks associated with development goals are updated in Career Development.

Generating the Spreadsheet

Generate the spreadsheet to upload and assign goals to a worker or to update existing goals for a worker:

1. Click Administer Goals in the Related Links panel on the My Goals page in the Goals work area.
2. On the Administer Goals page, select Worker Goals to open the Worker Goals section.
3. Click Upload and select the Upload Worker Goal Data action. A File Download dialog box appears.
4. Click Save. Select a destination on your local hard disk to save the WorkerGoalsWorksheet.xlsx spreadsheet.

**Note:** Ensure the spreadsheet isn’t in the protected state before you enter data.

Uploading a New Goal for a Worker

To upload a new goal for a worker:

1. Specify all the required columns in the Update Worker Goals worksheet.
Chapter 6

Spreadsheets for Uploading Goals

2. Click **Upload** to save the new goals into the Oracle Fusion HCM database.

When you upload a new goal of the goal type:

- Performance, the goal appears on the worker's My Goals page in the Goals work area.
- Development, the goal appears on the worker’s My Career Development page in the Career Development work area.

**Updating an Existing Goal Assigned to a Worker**

To update an existing goal assigned to a worker:

1. Specify goal attributes in the Search region of the Update Worker Goals worksheet.
2. Click **Download** to download the goal into the spreadsheet.
3. Click **Upload** to save the updated goals into the Oracle Fusion HCM database.

Updates to goal attributes associated with:

- A performance goal appear on the worker’s My Goals page in the Goals work area.
- A development goal appear on the worker’s My Career Development page in the Career Development work area.

**Uploading a New Measurement for a Worker Goal**

To upload a new measurement for a worker goal:

1. Specify all the required columns in the Update Measurements worksheet.
2. Click **Upload** to save the new measurements associated with worker goals into the Oracle Fusion HCM database.

New measurements associated with:

- A performance goal appear for the goal on the Goal Management pages.
- A development goal appear for the goal on the Career Development pages.

**Updating an Existing Measurement Associated with a Worker Goal**

To update an existing measurement for a worker goal:

1. Specify goal attributes in the Search region of the Update Measurements worksheet.
2. Click **Download** to download the goal and associated measurements data into the spreadsheet.
3. Update the measurement for a goal and click **Upload** to save the updated measurements for goals into the Oracle Fusion HCM database.

Updates to measurements associated with:

- A performance goal appear for the goal on the Goal Management pages.
- A development goal appear for the goal on the Career Development pages.

**Uploading a New Task for a Worker Goal**

To upload a new task for a worker goal:

1. Specify all the required columns in the Update Tasks worksheet.
2. Click **Upload** to save the new tasks associated with worker goals into the Oracle Fusion HCM database.

New tasks associated with:

- A performance goal appear for the goal on the Goal Management pages.
• A development goal appear for the goal on the Career Development pages.

Updating an Existing Task Associated with a Worker Goal

To update an existing task for a worker goal:

1. Specify goal attributes in the Search region of the Update Tasks worksheet.
2. Click Download to download the goal and associated tasks data into the spreadsheet.
3. Update the task-related attributes for a goal and click Upload to save the updated tasks into the Oracle Fusion HCM database.

Updates to tasks associated with:

• A performance goal appear for the goal on the Goal Management pages.
• A development goal appear for the goal on the Career Development pages.

Related Topics

• Using Desktop Integrated Excel Workbooks: Points to Consider

Using the Update Worker Goals Worksheet

Use the Update Worker Goals worksheet to upload new and updated worker goals to the database.

If a column header displays:

• An asterisk: The column value is required for a data row. You must enter a value in that column. Else, the application displays an error for the column.
• Double asterisks: The column value is required for a data row. However, if you don’t complete each column indicated with double asterisks, the application assigns a default value to the column.

For any missing data, the application displays an error message in the Status column for that goal.

Editing Columns in the Update Worker Goals Worksheet

The table shows a partial list of columns in the worksheet and corresponding valid values.

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Completion Percentage</td>
<td>The percentage completion of the goal. The valid values are:</td>
</tr>
<tr>
<td></td>
<td>• 0</td>
</tr>
<tr>
<td></td>
<td>• 25</td>
</tr>
<tr>
<td></td>
<td>• 50</td>
</tr>
<tr>
<td></td>
<td>• 75</td>
</tr>
<tr>
<td></td>
<td>• 100</td>
</tr>
<tr>
<td>Descriptive Flexfields</td>
<td>Descriptive flexfields related to a goal. The valid value for this column is a set of all descriptive flexfields values separated by the application-defined delimiter. You can double-click a cell to enter values for each descriptive flexfield separately in the flexfield picker. This column is displayed only</td>
</tr>
</tbody>
</table>
Using the Goals Update Measurements Worksheet

Use the Update Measurements worksheet to upload new and updated measurements associated with worker goals to the database.

If a column header displays:

- An asterisk: The column value is required for a data row. You must enter a value in that column. Else, the application displays an error for the column.
- Double asterisks: The column value is required for a data row. However, if you don’t complete each column indicated with double asterisks, the application assigns a default value to the column.

For any missing data, the application displays an error message in the Status column for that measurement.

To associate multiple measurements with a goal, enable the Multiple Measurements for Goals Enabled profile option in the application. Set the profile option in the Setup and Maintenance work area. You use the Manage Worker Goal Setting Profile Option Values or Manage Administrator Profile Values task to set profile option values.

If you define multiple measurements for a goal in the worksheet:

- When the profile option is enabled, you can view all measurements in the Measurements section for the goal.
- When the profile option is disabled, you can view only the measurement with the sequence number 1 in the Measurements section for the goal.

Editing Columns in the Update Measurements Worksheet

The table shows a partial list of columns in the worksheet and corresponding valid values.
Oracle Talent Management Cloud
Using Goal Management

Chapter 6

Spreadsheets for Uploading Goals

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sequence Number</td>
<td>Displays the sequence in which a measurement appear on the application pages and in Oracle Transactional Business Intelligence (OTBI) reports. Enter a numeric value in this column. Example: 1, 2, 3, 4, 5 and so on.</td>
</tr>
</tbody>
</table>
| Unit of Measure   | Specify the unit of measure for a measurement. The values in this column are populated using the Unit of Measurement for Goal Completion (HRG_GOAL_QUANTITATIVE_UOM) lookup. By default, the application displays the following units of measures:  
• None: Select when no unit of measure is applicable for the measurement.  
• Currency: Select to use currency as a unit of measure for the measurement.  
• Number: Select to use number as a unit of measure for the measurement.  
• Percent: Select to use percent as a unit of measure for the measurement. |
| Target Value      | Specify a numeric value that workers must target for the measurement to complete the goal. You must leave this column blank if you select None in the Unit of Measure column. |
| Actual Value      | Specify a numeric value to measure the actual performance of the worker for the goal. You must leave this column blank if you select None in the Unit of Measure column. |

Related Topics

• Goal Management Profile Options
• Goal Lookups: Explained

Using the Goals Update Tasks Worksheet

Use the Update Tasks worksheet to upload new and updated tasks associated with worker goals to the database.

If a column header displays:

• An asterisk: The column value is required for a data row. You must enter a value in that column. Else, the application displays an error for the column.
• Double asterisks: The column value is required for a data row. However, if you don’t complete each column indicated with double asterisks, the application assigns a default value to the column.

For any missing data, the application displays an error message in the Status column for that task.

To associate tasks with a goal, enable the Performance Goal Tasks Enabled profile option in the application. Set the profile option in the Setup and Maintenance work area. You use the Manage Worker Goal Setting Profile Option Values or Manage Administrator Profile Values task to set profile option values.

If you define tasks for a goal in the worksheet:

• When the profile option is enabled, you can view all tasks associated with a goal in the Tasks section for the goal.
• When the profile option is disabled, you can’t view any tasks defined for the goal.
Editing Columns in the Update Tasks Worksheet

The table shows a partial list of columns in the worksheet and corresponding valid values.

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>Specify the task type. The values in this column are populated using the Type of Goal Task (HRG_GOAL_TASK_TYPE) lookup.</td>
</tr>
<tr>
<td>Completion Percentage</td>
<td>The percentage completion of the task. The valid values are:</td>
</tr>
<tr>
<td></td>
<td>• 0</td>
</tr>
<tr>
<td></td>
<td>• 25</td>
</tr>
<tr>
<td></td>
<td>• 50</td>
</tr>
<tr>
<td></td>
<td>• 75</td>
</tr>
<tr>
<td></td>
<td>• 100</td>
</tr>
<tr>
<td>Priority</td>
<td>The priority of the task. The valid values are:</td>
</tr>
<tr>
<td></td>
<td>• High</td>
</tr>
<tr>
<td></td>
<td>• Medium</td>
</tr>
<tr>
<td></td>
<td>• Low</td>
</tr>
</tbody>
</table>

Related Topics
- Goal Management Profile Options
- Goal Lookups: Explained

Uploading and Assigning Organization Goals Using a Spreadsheet: Explained

HR specialists can upload and assign new organization goals to workers using an application-generated spreadsheet. The organization goals assigned using the spreadsheet appear in the goals list on the My Goals page of the selected workers. By default, these goals aren’t aligned to any goals.

To upload and assign new organization goals to workers, you must generate the spreadsheet using the option provided in the application. The application-generated spreadsheet for uploading organization goals contains the following two worksheets:

- Organization Goals Upload: Use this worksheet to upload new organization goals.
- Organization Goal Assignment: Use this worksheet to assign the new uploaded organization goals to workers.

Generating the Spreadsheet

You can generate the spreadsheet to upload and assign organization goals as follows:

1. Click Administer Goals in the Related Links panel on the My Goals page in the Goals work area.
2. On the Administer Goals page, select Organization Goals to open the Organization Goals section.
3. Click Upload and select the Upload Organization Goals action. A dialog box to download the file appears.
4. Click Save. Select a destination on your local hard disk to save the OrganizationGoalsWorksheet.xlsx spreadsheet.

Entering Data into the Spreadsheet
To upload a new organization goal, enter data for all the required columns in the Organization Goals Upload worksheet and click Upload. After you click Upload, click Save to commit the new organization goals into the HCM Cloud database.

Ensure that the spreadsheet isn’t in the protected state before you enter data.

Using the Spreadsheet to Assign Goals
After you upload organization goals using the application-generated spreadsheet, you must assign them to workers using the Organization Goal Assignment worksheet. To assign goals to workers:

1. In the Organization Goals Upload worksheet, click Download to download all the organization goals available in the database to the spreadsheet. The updated spreadsheet now includes the ID for all the uploaded goals.
2. In the Organization Goal Assignment worksheet, complete all the fields.

The ID for a goal is displayed on the Goal ID column of the Organization Goals Upload worksheet.

3. Click Upload. The data belonging to rows that display the text Row inserted successfully are uploaded.
4. Click Save to commit the data into the database. The uploaded organization goals are now displayed on the My Goals page of the worker to whom the goal was assigned.

Related Topics
- Using Desktop Integrated Excel Workbooks: Points to Consider
- Assigning Organization Goals: Explained

Using the Organization Goal Assignment Worksheet
Use the Organization Goal Assignment worksheet to assign organization goals that you uploaded using the Organization Goals Upload worksheet, thereby enabling workers to access their organization goals.

Editing Columns in the Organization Goal Assignment Worksheet
The table shows a partial list of columns in the worksheet and corresponding valid values.

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Goal ID</td>
<td>The organization goal ID. The goal ID is displayed on the Goal ID column of the Organization Goals Upload worksheet.</td>
</tr>
</tbody>
</table>
Using the Organization Goals Upload Worksheet

Use the Organization Goals Upload worksheet to upload organization goals that HR specialists can then assign to workers. If you don’t complete each required column, then the application assigns a default value to the column or displays an error message about data missing in the Status column for that goal.

Editing Columns in the Organization Goals Upload Worksheet

The table shows a partial list of columns in the worksheet and the corresponding valid values.

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Workers to Update Goals</td>
<td>Whether the worker is allowed to edit key fields, including goal name, description, and target completion date. The valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Y</td>
</tr>
<tr>
<td></td>
<td>• N</td>
</tr>
<tr>
<td>Key</td>
<td>The goal key. The goal key appears on the Key column of the Organization Goals Upload worksheet.</td>
</tr>
</tbody>
</table>

**Column name**

**Description**

<table>
<thead>
<tr>
<th>Column name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Goal ID</td>
<td>The unique identifier of the goal. Leave this column blank.</td>
</tr>
<tr>
<td>Created By</td>
<td>The person ID of the user who created the goal or assigned the goal, or both. The valid value is the person ID of a line manager who is also the organization owner. If no data exists, the ID of the logged-in user is assigned by default.</td>
</tr>
<tr>
<td>Published</td>
<td>The goal is published or not. The valid values are:</td>
</tr>
<tr>
<td></td>
<td>• Y</td>
</tr>
<tr>
<td></td>
<td>• N</td>
</tr>
<tr>
<td>Completion Percentage</td>
<td>The percentage completion of the goal. The valid values are:</td>
</tr>
<tr>
<td></td>
<td>• 0</td>
</tr>
<tr>
<td></td>
<td>• 25</td>
</tr>
<tr>
<td></td>
<td>• 50</td>
</tr>
<tr>
<td></td>
<td>• 75</td>
</tr>
<tr>
<td></td>
<td>• 100</td>
</tr>
</tbody>
</table>
FAQs for Spreadsheets for Uploading Goals

Can I copy goals from an external database?

Yes, you can copy the details of existing goals from an external database into a spreadsheet template to upload them to the Oracle Fusion database.

What's a key performance goal field?

Configure a key goal field for performance goals to require manager approval when edited.

The key performance goal fields are:

- Goal Name
- Description
- Success Criteria
- Start Date
- Target Completion Date
- Priority
- Category
- Weight
- Measurement Name
- Unit of Measure
- Target Type
- Target Value
- Private
7 Mass Assignment of Goals

Mass Assignment of Performance Goals: Explained

Mass assign goals is a feature for assigning performance goals, including organization goals, to a number of people at the same time. As an HR specialist, you can create a mass assignment request, select performance goals from the goal library, or create and add performance goals to the request. You must then submit the request to assign the selected performance goals to a selected population of workers. As a requester for a manager, you can use this feature to assign the performance goals of that manager. The organization goals assigned using a mass assignment request appear in the goals list on the My Goals page of the selected workers. By default, these goals aren't aligned to any goals.

To open the Mass Assign Goals page:

1. Select Navigator > My Client Groups > Goals.
2. In the Related Links panel on the Tasks tab, click Mass Assign Goals. The Mass Assign Goals page is displayed.

On the Mass Assign Goals page, you can create a mass assignment request. You can also search for and update an existing mass assignment request to suit business needs.

With the mass assign goals feature, you can:

- Assign performance goals to managers and all of their reports or to their direct reports only.
- Exclude specific individuals from a manager’s direct or all reports lists.
- Assign a manager’s individual performance goals to the manager’s reports for managers who haven’t created organization goals.

Goal Plans for Goals Assigned Using a Request

Using a mass assignment request, you can assign performance goals to workers by:

- Selecting a specific goal plan
- Letting the application automatically select an active goal plan with the latest start date and with a duration spanning the goal's start date

**Note:**
- If there is no worker goal plan that spans the goal duration, the goal isn’t assigned to the worker.
- If there is more than one goal plan that spans the goal duration, the goal is associated with the goal plan with the latest start date.

The goal plan selected specifically or automatically is assigned to workers, if it’s not already assigned.

Eligibility Profiles for Goals Assigned Using a Request

Using a mass assignment request, you can select eligibility profiles to assign performance goals only to workers who meet the profile criteria.
Related Topics

- Using Eligibility Profiles for Performance Goals Assignment: Explained
- Managing Scheduled Processes for Assigning Performance Goals: Procedure
- Assigning Organization Goals: Explained

Creating a Request for Mass Assignment of Performance Goals: Points to Consider

Depending on your role and security privileges, you can create mass assignment requests for performance goals. Use the Mass Assign Goals link in the Related Links panel on the Tasks tab in the Goals work area to create mass assignment requests for performance goals.

Create mass assignment requests to assign goals to workers on behalf of their managers. When creating a request, you must decide:

- The process name
- Whether to create the request on behalf of a person
- Which worker goal plan to select in the request to associate with the included goals
- Which goals to select in a mass assignment request
- Whether to assign goals to manager hierarchies or individuals
- Whether to add eligibility profiles to the request now or later
- When to schedule a mass assignment request

Deciding the Process Name

When you create a mass assign process, you must decide the name of the process. You can use the process name to edit, duplicate, or schedule it later.

Requesting on Behalf of a Person

You can create a mass assignment request on behalf of a person, such as a line manager.

Selecting a Goal Plan

Select a specific worker goal plan or let the application automatically select a worker goal plan with the latest start date and its duration spanning the goal’s start date. The selected goal plan is assigned to workers, if it’s not already assigned.

Selecting Goals for a Mass Assignment Request

You must add performance goals when you create a mass assignment request. These goals are available to workers after the service process for the request is complete. You can add new goals, or select and add those from the goal library or organization goals to the goal plan. You can also use the duplicate action for a goal to assign a separate copy of the goal to workers. If you specify a requester, then you can add new goals or goals that are already assigned to the person on whose behalf you are requesting the mass assign process.
Adding Eligibility Profiles to a Mass Assignment Request
Add eligibility profiles to a mass assignment request to assign performance goals included in the request to individuals who meet the criteria of all required profiles. You can limit assigning goals to workers who meet eligibility requirements by job, job role, location, age, or other criteria. For example, add a location eligibility profile to a request to restrict goals to individuals who are located in a certain place. You can further refine eligibility by adding length of service criteria to restrict workers by location and length of service.

Assigning Goals to Manager Hierarchies and Individuals
You assign performance goals on behalf of a manager or selected individuals by creating and submitting a mass assignment request on the Mass Assign Goals page. If you select a manager in the request, then only the performance goals visible to the selected manager are available for the assignment. You can mass assign the selected performance goals to the manager’s direct, indirect, or selected reports. To select or deselect assignees, click the link to the number displayed in the Assignee Details column. You can also view details such as job, location, and department for each assignee.

Scheduling Mass Assignment Requests
After you save and close a request on the Mass Assign Goals page, you can schedule the process for the assignment. Click Manage Scheduled Process on the Mass Assign Goals: Search page to open the Manage Goal Scheduled Process page. You can run the process straight away or at a scheduled time (once or at recurring intervals.) After the process is complete, the goals included in the request are assigned to all workers that were selected in the request. To view the result, click the Assignment Results button on the Mass Assign Goals page.

You can also use the Goals work area to open the Manage Goal Scheduled Process task in the Related Links panel on the Tasks tab.

If you rerun the process for an existing request, edit a mass assignment request and then rerun the process, or submit a new request:

- Any new workers selected in the request are assigned the included goals.
- Any new goals included in the request are assigned to the selected workers if they fall within a worker goal plan.
- Any goals included in the request, but already assigned to the selected workers remain assigned. There are no changes to such goals for the selected workers.
- Any goals included in the request, but assigned earlier to any workers excluded later from the request remain assigned to them. There are no changes to such goals for the excluded workers. You must manually remove the goal from the goal plan for any workers included in any earlier submissions.

Related Topics
- Using Eligibility Profiles for Performance Goals Assignment: Explained
- Managing Scheduled Processes for Assigning Performance Goals: Procedure
Chapter 8
Goal Library

Goal Library: Explained

The goal library is a repository of reusable goals that you create and maintain to manage the enterprise goal-setting process efficiently. HR specialists create performance goals that are used by Goals, Performance Management, and Talent Review work areas, and development goals used by Career Development, Talent Review, and Succession Management work areas. Organization owners, managers, and workers can search the goal library to copy the goals. Managers and HR specialists can assign the goals through goal plans in the Goal Management work area, to a selected population. Use the goal library to define goals consistently and reduce the effort of creating a new goal if similar goals already exist. To add goals from the goal library, organization owners, managers, and workers can search for goals using different criteria such as goal name, type, and status. You can add a goal to the goal library by using the Manage Goal Library task:

- In the Related Links panel on the Tasks tab in the Goals work area.
- In the Related Links panel on the Tasks tab in the Career Development work area.

The goal library is maintained as part of the content library in the Profile Management work area.

In the goal library, you can:

- Add goals
- Edit goals
- Set the status of goals
- Decide the accessibility of a goal

Adding Goals

You can add goals to the library, specify their goal type and determine their attributes, including: name, description, success criteria, target completion date, and more. You can use the External ID attribute to refer to a performance goal in external applications. This attribute value is either application-generated or user-defined based on the application configurations. In addition to the goal type, you can also decide the subtype of a goal. A subtype is a method for further classifying a goal within a goal type. Subtypes are configured based on business requirements. You can also add target outcomes, if available, to the goal. When you copy a goal from the library, you can change the goal attributes as appropriate.

Note: If you create goals anywhere except the goal library, such as in a performance document, the Goals page, or talent review, the application doesn’t add these goals to the goal library. You can view such goals from the worker’s person spotlight and on all other pages where the goal is included except in the goal library.

Editing Goals

You can edit a goal in the goal library at any time, regardless of whether people have already copied the goal. Changes that you make to goals in the library don’t affect those that have been copied and are in current use, because there is no link between the two versions of the goal. You can’t edit the external ID for a goal.
Setting the Goal Status

By default, the status of a goal you create is set to **Active** to make it available to copy. You can set the status of a goal to **Inactive**, even if the goal has been copied and is currently being used by workers. If you change the status of the goal to inactive, then it’s no longer available for copying. You can make the goal inactive, for example, to edit it, then restore it to **Active** status to make the edited goal available again.

Deciding the Accessibility of a Goal

When you edit or add a goal, you select whether to make goals available to a role. By default, all roles have access to the goal. You can decide whether to give access to the goal only to HR specialists, or also include managers and workers.

**Related Topics**

- Career Development: Explained
- Goal Management: Explained
- Profile Management: Explained
- Succession Management: Explained
- Talent Review: Explained
9 Goal Plans

Goal Plans: Explained

Goal plans are a collection of performance goals grouped by common characteristics. For example, a specified time frame and a particular department that must work on them. Depending on security privileges assigned to your role, you can create goal plans. Use the Manage Goal Plans task in the Related Links panel on the Tasks tab in the Goals work area to create goal plans. Each worker must be assigned a goal plan so that you can add or assign goals to the worker within the goal plan duration. In the Goal Plan list displayed on Goal Management pages, goal plans are sorted alphabetically by their names.

Two types of goal plans are available:

- **Worker plan**: Use this type to assign goals to individuals for a specific period
- **Organization plan**: Use this type to assign the plan to departments so that organization owners of each department can associate goals with the plan and assign and publish such goals for their organization.

After you create a goal plan, you can’t delete it. However, you can change the status of an existing goal plan to inactive. Inactive goal plans aren’t available for use and don’t appear on the application pages. Use the Manage Goal Plans task to search for an existing goal plan and edit the goal plan to change its status to active or inactive. You can open the Manage Goal Plans page in the Related Links panel on the Tasks tab in the Goals work area.

**Related Topics**

- Mass Assignment of Performance Goals: Explained

Worker Goal Plans: Explained

Worker goal plans are a collection of performance goals grouped by common characteristics. For example, a specified time frame and a particular department that must work on them. Use the Manage Goal Plans task in the Related Links panel on the Tasks tab on the My Goals page in the Goals work area to create worker goal plans.

Using worker goal plans, you can:

- Associate review period and group goals to track them for a specific population and time period within the review period.
- Enable weight for goals at the goal plan level and add relative weights for goals added to the goal plan.
- Select document types to populate goals from a goal plan in performance documents that use the selected document types.
- Add goals to a goal plan.
- Assign goals to a specific population.
- Associate goals with existing goal plans.

**Note**: Before creating a goal plan, you must first create a review period to associate with the goal plan.
Grouping and Tracking Goals for a Specific Period

Create goal plans to:

- Associate them with a review period linked also to performance documents
- Contain goals for a group of individuals
- Track worker performance for the period of the goal plan

Workers can use worker goal plans to sort and track their individual goals. Therefore, ensuring that they have appropriate goals for the goal plan period.

Adding Relative Weights for Goals

When creating a goal plan, you can select the option to enable to entering goal weights for a plan. You can further select the option to ensure that the sum of all goal weights in the goal plan is 100%. You can allocate weight to each goal included in the goal plan. Managers and workers can modify the weight for each goal for a goal plan later. A goal weight indicates the relative importance of each goal in the goal plan. Other Oracle Fusion Applications products can consume these weights in their processes. For example, the incentive compensation plan can use these weights and the worker’s actual achievement of the goal objectives, to calculate the worker’s incentive pay.

Including Goal Plans in Performance Documents

When creating a goal plan, you can select document types to populate goals from the goal plan in performance documents that use the selected document types.

Assigning Goals to a Specific Population

When creating a worker goal plan, you can assign goals that are specific to individuals and to the hierarchical structure of one or more managers. You can also select eligibility profiles to assign goals to individuals that meet all the criteria of required eligibility profiles and at least one eligibility profile not required, if added.

After creating a goal plan, you can add goals to the goal plan, if allowed for your user role, at any time within the time period that the goal plan is active. When you use the Mass Assign Goals feature, the application associates the assigned goals with a selected worker plan or with the worker plan that has start and end dates that include the goal:

- Start date
- Target completion date
- Actual completion date

Workers and managers can edit goals to accommodate their specific circumstances after the goals are assigned.

Associating Goals with Existing Goal Plans

HR specialists can always add goals to a goal plan. If managers and workers are allowed to add goals to the goal plan, they can add goals to an existing goal plan. The goals they plan to add must have start, target, or actual completion dates within or equal to the start and end dates of the goal plan. To let a worker continue working on the goal for a period later than the current goal plan, extend the goal to another goal plan. After extending, the goal is associated with both the source and target goal plans. Any subsequent changes to the goal in the source goal plan are also carried onto the target goal plan.
Organization Goal Plans: Explained

Organization goal plans are a collection of organization goals grouped by common characteristics. For example, a specified time frame and a particular department that must work on them. Use the Manage Goal Plans task in the Related Links panel on the Tasks tab in the Goals work area to create organization goal plans.

Using organization goal plans, you can:

- Associate a review period with the plan to track organization goals, included later, for your organization and time period within the review period.
- Enable weight for goals at the goal plan level and add relative weights for organization goals, added later to the goal plan.
- Assign the organization goal plan to departments.
- Associate organization goals with existing organization goal plans.

Note: Before creating a goal plan, you must first create a review period to associate with the goal plan.

Grouping and Tracking Goals for a Specific Period

Associate review periods with organization goal plans to track goals for your organization. The goal plan period must be within the associated review period. Organization owners can use organization goal plans to sort and track their organization goals. In the Goal Plan list displayed on Goal Management pages, goal plans are sorted alphabetically by their names.

Adding Relative Weights for Goals

When creating a goal plan, you can select the option to enable entering goal weights for a plan. You can further select the option to ensure that the sum of all goal weights in the goal plan is 100%. You can allocate weight to each goal included in the goal plan. Managers and workers can modify weight for each goal for a goal plan later. A goal weight indicates the relative importance of each goal in the goal plan. Other Oracle Fusion Applications products can consume these weights in their processes. For example, the incentive compensation plan can use these weights and the worker's actual achievement of the goal objectives, to calculate the worker's incentive pay.

Assigning Goal Plans to Departments

When creating an organization goal plan, you can select all departments within your organization or specific departments. To select departments within an organization, the security profile associated with your role must have adequate privileges to view organization data. When you search for a specific department, the application returns only those departments that have managers with active assignments associated with them.

Associating Goals with Existing Goal Plans

If you have organization goal plans assigned to you, then you can add goals to the plan on the My Organization Goals page in the Goals work area. If you later edit dates of an existing organization goal plan and dates of the associated organization goals aren’t within the new dates of the goal plan, the goal plan date changes are cascaded to the associated organization goals.
Creating Goal Plans: Points to Consider

Depending on the security privileges assigned to your role, you can create goal plans to aid your workers and managers in tracking and sorting performance goals. To use goal plans, you must decide:

- The goal plan type
- The review period associated with a goal plan and dates that a goal plan is active
- The individuals to whom to assign the goal plan and whether to add eligibility profiles to the plan
- Whether to add goals to the plan now or later
- When to schedule a goal plan for assigning goals

Selecting the Goal Plan Type

Select the goal plan type as:

- Worker plan to assign goals included within the goal plan to workers
- Organization plan to assign the goal plan to organization owner of departments within organizations

Selecting Review Period and Goal Plan Active Dates

You can associate a review period with a goal plan when creating the goal plan. The goal plan start and end dates must be within or equal to the selected review period. Goals with start dates, target completion dates, or actual completion dates that fall within the start and end dates of a worker plan can belong to the plan.

Assigning the Plan

Workers, managers, and departments can have more than one goal plan assigned to them. For example, you can create a worker goal plan for a manager’s direct and indirect reports so that workers have one plan that is active now and another worker goal plan with a future start date. You can use the future worker goal plan to hold goals that will be addressed later, or current goals that span a longer period than the current goal plan. They can also have concurrent plans of different types. For example, one organization plan for organization goals and another worker plan for other performance goals.

Assign an organization goal plan to departments. You can select all departments within the organization that you belong or select specific departments. When selecting specific departments, you can search for a department within an organization. After you submit the goal plan for assignment using the scheduled process for assigning goal plans, the goal plan is assigned to all line and executive managers who are under the selected department. Assigning organization goal plans to departments makes the plans visible to line managers or executive managers on the My Organization Goals page. On that page, managers can view and assign goals to the plan. They can then create and publish organization goals from the page. If the notification is enabled, only the actual organization owner of the department receives a notification about the goal plan assigned to the organization. The actual organization owner of a department is specified in the Workforce Structures work area. You edit the owner of an organization using the Manage Departments task in the Workforce Structures work area.

Assign a worker goal plan to a manager hierarchy or individuals. Goals included within the worker plan are assigned to the new people to whom the plan is assigned. You can add eligibility profiles to worker goal plans to assign goals included in the plan to individuals who meet the criteria of all required profiles. You can restrict goals to workers who meet eligibility requirements by job, job role, location, age, or other criteria. For example, you can add a location eligibility profile to a goal.
Adding Goals to a Worker Plan
You can add goals that you create yourself or that you select from a goal library to the worker goal plan. In addition:

- If your enterprise uses tasks, measurements, and target outcomes, you can add those to the goals you add to the plan.
- If you have goals that apply to a wide population, you can assign these to the plan directly.
- If goals are generally added by managers and workers, you can assign one goal plan to a wide population without goals.

If you select **HR specialist, manager, and worker** for the **Allow Updates to Goals By** option, you can allow workers to update either the key attribute or all attributes of a goal.

Scheduling a Plan
After you submit a goal plan on the Create or Edit Goal Plan page, you must submit it for assignment. To submit the goal plan for assignment, you must search for and select the goal plan and click **Manage Scheduled Process** to run the process immediately or at a scheduled time (once or at recurring intervals.) After the process is complete:

- The worker goal plan and any goals included in the plan are assigned to all workers selected in the plan.
- The organization goal plan is associated with the departments selected in the plan. Managers associated with those departments can then create their organization goals in that plan.

You can also use the Goals work area to open the Manage Goal Scheduled Process task in the Related Links panel on the Tasks tab.

If you rerun the process for an existing worker goal plan, edit a worker goal plan and then rerun the process, or submit a new worker goal plan:

- Any new workers selected in the goal plan are assigned the included goals.
- Any new goals included in the goal plan are assigned to the selected workers.
- Any goals included in the goal plan, but already assigned to the selected workers remain assigned. There are no changes to such goals for the selected workers.
- Any goals included in the goal plan assigned earlier to any workers excluded later from the goal plan remain assigned to them. There are no changes to such goals or goal plans for the excluded workers. You must manually remove the goal from the goal plan for any workers included in any earlier submissions.

Goal Plans: Examples

The Goals work area includes worker goal plans for performance goals available to assign to workers and organization goal plans for organization goals available to assign to departments within organizations. The following examples illustrate how HR specialists and managers can use goal plans to track performance goals of workers.
Adding Additional Goals to Goal Plans with Existing Goals

Your company uses worker goal plans associated with review periods to manage worker performance goals. The company requires that the entire staff must complete at least one performance goal: Complete Ethics Course within a review period. Emily Thorne, a manager, wants to add additional performance goals to the worker goal plan for all of her direct reports. In the company, HR specialists have security privileges to manage goal plans. Workers and managers can only manage goals within goal plans.

The HR specialist creates a worker goal plan for all workers in the company for the appropriate review period and includes the Complete Ethics Course goal. Emily uses the My Team Goals page to add additional goals to the worker goal plan for each of her direct reports.

Adding Performance Goals to Reports' Goal Plans

Emily wants to assign performance goals to a direct report.

The HR specialist creates the worker goal plan for all of Emily’s direct and indirect reports. From the My Team Goals page, Emily opens the worker’s Goals page. She then adds performance goals to the report’s worker goal plan.

Adding Organization Goals to a Goal Plan

Emily wants to add and publish organization goals to her organization.

The HR specialist creates the organization goal plan and assigns it to Emily’s department. Emily adds goals to the organization plan on the My Organization Goals page and publishes them to make them available to the entire organization to assign, add, or align.

Adding Goals to a Goal Plan: Explained

Depending on your security privileges and role, you can add performance goals to worker and organization goal plans.

To add goals to a worker goal plan, use one of the following pages in the Goals work area, if available:

- Manage Goal Plans
- Mass Assign Goals
- My Goals
- My Team Goals

To add goals to an organization goal plan, use the My Organization Goals page, if available.

Adding Goals to a Worker Goal Plan from the Manage Goal Plans page

On the Manage Goal Plans page, you can add goals to worker goal plans that you manage. You can also add goals to a worker goal plan when creating the plan. To create a worker goal plan, you must first create a review period you associate
with the goal plan. Goals added to a goal plan are available to the workers and managers after the goal plan is submitted for assignment. Workers and managers can edit the assigned performance goals to suit the needs of the worker or enterprise.

---

**Adding Goals to a Worker Goal Plan from the Mass Assign Goals Page**

On the Mass Assign Goals page, when you create or edit a mass assignment request, you can select to add goals to a specific goal plan or the latest goal plan for selected workers. The goal plan selected specifically or automatically is assigned to selected workers, if not already assigned. Goals added using a mass assignment request are available to the workers and their managers after the process is submitted for assignment. Workers or managers can edit the assigned performance goals to suit the needs of the worker or enterprise.

---

**Adding Goals to a Worker Goal Plan from the My Goals Page**

On the My Goals page, you can add goals to only those goal plans that are assigned to you. Ensure that the goal start date, target completion date, or actual completion date falls within the start and end dates of the plan.

To add a goal to a goal plan from the My Goals page, do the following tasks:

1. Select the review period with which the goal plan is associated
2. Select the goal plan set, if available, that includes the goal plan
3. Select the goal plan to which you want to add the goal

![Note:](image)
The application displays only those existing goal plans that are within the goal dates and are assigned to you.

4. Click **Add Goal** and select one of the following options to add a goal:
   - **New Goal**: To add a new goal
   - **Library Goal**: To select and add a goal from the goal library
   - **Other Sources**: To select and add a goal from other sources such as published organization goals or goals shared by your manager or colleague.

---

**Adding Goals to a Worker Goal Plan from the My Team Goals Page**

On the My Team Goals page, you can add goals to your direct reports’ goal plans by using the:

- **Add Goal** option. When you use this option, you can select multiple workers and add goals to goal plans of the selected workers. However, if no goal plan is assigned to a worker within the selected review period, you can’t add goals for that worker.

Before you add goals, you must first select the review period associated with the worker goal plan on the My Team Goals page. You can then click **Add Goal** and select one of the following options to add a goal:

   - **New Goal**: To add a new goal
   - **Library Goal**: To select and add a goal from the goal library

- **Report’s Goals page**: You can click a report’s name on the My Team Goals page to open that report’s Goals page. On the Goals page, you can add goals to only those goal plans that are assigned to your report. Ensure that the goal start date, target completion date, or actual completion date falls within the start and end dates of the plan.
To add a goal to a goal plan from the report's Goals page:

a. Select the review period with which the goal plan is associated.
b. Select the goal plan set, if available, that includes the goal plan.
c. Select the goal plan to which you want to add the goal.

Note: The application displays only those existing goal plans that are within the goal dates and are assigned to the report.

d. Click Add Goal and select one of the following options to add a goal:

- New Goal: To add a new goal
- Library Goal: To select and add a goal from the goal library

You can also select whether to allow workers to update key attributes of goals.

Adding Goals to an Organization Goal Plan from the My Organization Goals Page

For organization goal plans, organization owners add goals to goal plans from the My Organization Goals page in the Goals work area. To add organization goals, you must have an organization goal plan assigned to you.

To add a goal to an organization goal plan from the My Organization Goals page:

1. Select the review period with which the goal plan is associated
2. Select the goal plan set, if available, that includes the goal plan
3. Select the goal plan to which you want to add the goal

Note: The application displays only those existing goal plans that are within the goal dates and are assigned to you.

4. Click Add Goal and select one of the following options to add a goal:

  - New Goal: To add a new goal
  - Library Goal: To select and add a goal from the goal library

FAQs for Goal Plans

How can I create worker goal plans for people who are new to the organization?

Depending on your role and security privileges, you can either add individuals to an existing worker goal plan, or create a new worker goal plan and assign it to individuals who are new to the organization. If you add new performance goals to an existing worker goal plan, the new goals are assigned to everyone to whom the goal plan is assigned. However, any goals included earlier in an existing goal plan but already assigned to any selected workers remain assigned. There are no changes to such
goals for the selected workers. Similarly, if you remove any workers included earlier in the goal plan and resubmit the process to assign the goal plan, the goal and the goal plan remain assigned to the excluded workers.

How can I delete a goal plan?

You can delete a goal plan that isn’t assigned to any workers. However, you can’t delete an assigned goal plan, worker or organization. You can only change the status of an assigned goal plan to either active or inactive. Inactive goal plans aren’t available for use and don’t appear on the application pages.

What’s the difference between extending a goal and moving a goal to another worker goal plan?

When you move a goal to another worker goal plan, the goal is no longer associated with the source goal plan. For example, you move a goal to another worker goal plan when you want to associate the goal with a different performance document. When you extend a goal to another worker goal plan, the goal is associated with both source and target worker goal plans. Except for the goal weight, any changes to the goal are visible in both the source and target goal plans after you extend the goal. For example, if you couldn’t complete a goal before the end date of the source worker goal plan, you extend the goal to another worker goal plan to continue working on the goal for an extended duration.

How can I extend a goal to another worker goal plan?

On the My Goals page, select the review period and the worker goal plan your goal is associated with, and then select the Extend action for the goal. In the Target Goal Plan field, select the worker goal plan to which you want to extend the goal. By default, the start and target completion dates of the goal are the current goal plan start and end dates respectively. You can accept the default dates or enter new dates within the target goal plan period. Click Save and Close to save your changes.

How can I move a goal to another goal plan?

To move an organization goal, on the My Organization Goals page, select the review period and the organization goal plan your goal is associated with, and then select the Move action for the goal. In the Target Goal Plan field, select the organization goal plan to which you want to move the goal. By default, the dates of the goal change to the target goal plan start and end dates. You can accept the default dates or enter new dates within the target goal plan period. Click Save and Close to save your changes.

To move a worker goal, on the My Goals page, select the review period and the worker goal plan your goal is associated with, and then select the Move action for the goal. In the Target Goal Plan field, select the worker goal plan to which you want to move the goal. By default, the start and target completion dates of the goal are the target goal plan start and end dates respectively. You can accept the default dates or enter new dates within the target goal plan period. Click Save and Close to save your changes.

HR specialists can move a worker goal to another goal plan by using the Administer Goals task in the Goals work area. Select Worker Goals on the Administer Goals page in the Goals work area to search for and select the worker goal. From the Actions menu in the search results toolbar, select Move to move the goal to another goal plan.
10 Goal Plan Sets

Goal Plan Sets: Explained

Goal plan sets are one or more goal plans that you assign as a group to a population set. For example, group all goal plans intended for an upcoming salary review period in a goal plan set and assign the set to workers involved in the review. The goal plans and the goal plan set must be associated with the same review period. Depending on your role and security privileges, you can create goal plan sets. Use the Manage Goal Plan Sets link in the Related Links panel on the Tasks tab in the Goals work area to create goal plan sets. You can enable goal plan sets through a profile option.

Using goal plan sets, you can:

- Group goal plans for evaluating the overall progress and performance of a worker
- Assign specific goal plans with relative weights to a specific population

Goal Plan Grouping and Tracking for Specific Periods

HR specialists create goal plan sets for a review period to:

- Group goal plans within the same review period to assign them to a group of individuals
- Track worker performance for the period of the goal plan set

Associate goal plans with a goal plan set before submitting a goal plan set for assignment. The start and end dates of the review period associated with goal plans must fall between the dates that the goal plan set is active. In the Goal Plan list displayed on Goal Management pages, goal plans are sorted alphabetically by name.

Relative Weights for Goal Plans for Specific Populations

When creating a goal plan set, you can allocate weight to each goal plan so the sum of weights of all goal plans is 100, if enabled. You can assign goal plans to individuals, a selected hierarchy, or a wider population within the organization. You can select eligibility profiles at any time. Use eligibility profiles to ensure that the goal plan set is assigned to all individuals who meet the eligibility criteria. You must add goal plans to the goal plan set before you submit the goal plan set for the goals assignment. You can select existing goal plans or create a goal plan.

After you submit and assign a goal plan set, you:

- Can’t remove or add goal plans to the goal plan set.
- Can remove or add individuals and eligibility profiles to the goal plan set at any time.

>Note: You can’t delete an assigned goal plan set. However, you can delete an unassigned goal plan set.

Related Topics

- Goal Management Profile Options
Creating Goal Plan Sets: Points to Consider

You can use goal plan sets to group performance goal plans for evaluating the overall progress and performance of a worker. Assign specific goal plans with relative weights to a specific population. Depending on your role and security privileges, you can create goal plan sets. Use the Manage Goal Plan Sets link in the Related Links panel on the Tasks tab in the Goals work area to create goal plan sets.

**Note:** The Manage Goal Plan Sets link is displayed only when the Goal Plan Sets Enabled profile option is set to Y. You can set the value of the profile option using the Manage Worker Goal Setting Profile Option Values task in the Setup and Maintenance work area.

A goal plan can be associated with multiple goal plan sets if a goal plan set and the goal plan are associated with the same review period.

To create goal plan sets, you must decide:

- Dates that a goal plan set is active
- The individuals to whom to assign the goal plan set and whether to add eligibility profiles
- Which goal plans to add to the goal plan set
- How much weight to allocate to the included goal plans
- When to schedule the assignment of the goal plan set

Selecting Review Period and Goal Plan Set Active Dates

You must select a review period such that the start and end dates for the goal plan set fall within the review period. Use review periods to determine which goal plans are eligible to belong to a goal plan set. Active goal plans associated with a review period that fall within the start and end dates of a goal plan set can belong to the set.

Assigning the Goal Plan Set

You assign goal plan sets to a selected hierarchy or individuals when creating the goal plan set or at a later time. You can also exclude specific assignees reporting to a manager. When assigning more than one goal plan set to an individual, ensure that the dates on which sets are active don’t overlap with each other. For example, create a current goal plan set for a manager’s direct and indirect reports so that workers have one goal plan set that is active now, and another with a future start date. You can use the future goal plan set to hold goal plans that will be addressed later, or current goal plans that span a longer period than the current goal plan set. After you submit a goal plan set for assignment, you can add or remove individuals, and then resubmit the set for assignment.

Add eligibility profiles to a goal plan set to ensure goal plans added to the goal plan set are assigned to individuals who meet the criteria of all required profiles. For example, you can add a location eligibility profile to a goal plan set to assign goal plans to individuals who are located in certain place. You can further refine eligibility by adding length of service criteria to restrict workers by location and length of service.

Adding Goal Plans to the Goal Plan Set

When creating a goal plan set, you can create a goal plan or search and select from existing goal plans to add them to the set. You can only add active goal plans that have start and end dates within the start and end dates of the set and are within
the same review period. After you add a goal plan, goal plans appear alphabetically sorted in the Goal Plan list displayed on Goal Management pages.

### Allocating Weights to the Goal Plans

Allocate weight to each goal plan included in the goal plan set so the sum of weights of all goal plans is 100, if enabled. A goal plan weight indicates the relative importance of each goal plan. Other Oracle Fusion Applications products can consume these weights in their processes. For example, the incentive compensation plan can use these weights and the worker’s actual achievement of the goal objectives, to calculate the worker's incentive pay.

### Scheduling the Assignment of the Goal Plan Set

After you save and close a new goal plan set on the Manage Goal Plan Sets page, you must submit the goal plan set for assignment. To submit a goal plan set for assignment, search for and select the goal plan set on the Manage Goal Plan Sets page and click Manage Scheduled Process. On the manage Goal Scheduled Process page that appears, you can run the process as soon as possible or at a scheduled time (once or at recurring intervals.) After the process is completed, the goal plans included in the goal plan set are assigned to all individuals who were selected in the goal plan set. The population settings selected at the individual goal plan level isn’t used during the assignment of goal plan sets.

Tip: You can also use the Goals work area to open the Manage Goal Scheduled Process task in the Related Links panel on the Tasks tab.

If you rerun the process for an existing goal plan set, edit a goal plan set and then rerun the process, or submit a new goal plan set:

- New workers selected in the goal plan set are assigned the included goal plans and associated goals within the goal plan.
- New goal plans included in the goal plan set are assigned to the selected workers.
- Goal plans included in the goal plan set, but already assigned to the selected workers remain assigned. There are no changes to such goal plans for the selected workers.
- Goal plans included in the goal plan set and assigned earlier to any workers excluded later from the goal plan set remain assigned to them. There are no changes to such goals or goal plans for the excluded workers. You must manually remove the goal from the goal plan for any workers included in any earlier submissions. You can’t delete a goal plan assigned to a worker.

**Related Topics**

- Using Eligibility Profiles for Performance Goals Assignment: Explained
- Goal Management Profile Options
- Managing Scheduled Processes for Assigning Performance Goals: Procedure
Changing the Weight of a Goal Plan in a Goal Plan Set: Procedure

HR specialists can change the weights of goal plans included in a goal plan set for a worker.

To change the weight of a performance goal plan included in a goal plan set for a worker, follow these steps:

1. In the Goals work area, in the Related Links panel on the Tasks tab, click Administer Goals. The Administer Goals page appears.
2. Select the Worker Goal Plan Sets option.
3. Search for the goal plan set associated with the worker.
4. Click the link to the goal plan set in the Search Results table. The page with the name of the goal plan set for the worker appears.
5. Select the row for the goal plan set from the page table.
6. On the Actions menu, select Change Goal Plans Weight. The dialog box with the name of the goal plan set appears.
7. Update the weight for the goal plan and click OK to close the dialog box. The updated weight of the goal plan appears in the page table.

Note: The goal plan set enforces the sum of weights of the included goal plans to total 100. Therefore, adjust the weight of remaining goal plans in the set such that their sum is 100. If there is only one goal plan in the set, the weight of that goal plan must be 100.

8. Click Done to return to the Administer Goals page.

Related Topics
- Goal Plans: Explained

Deciding Effective Dates of Goal Plan Sets: Explained

The application-assigned effective date of a goal plan set for a worker is decided by the scenario in which the set was assigned to the worker. The effective dates of the goal plans included in the goal plan set are automatically updated to the application-assigned goal plan set effective dates.

The following table describes scenarios in which a goal plan set is assigned to a worker and the application-assigned effective dates of the goal plan set.

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Effective Dates of the Goal Plan Set for the Worker Is</th>
</tr>
</thead>
<tbody>
<tr>
<td>The goal plan set is assigned to the worker prior to the beginning of the goal plan set duration.</td>
<td>As included in the goal plan set.</td>
</tr>
<tr>
<td>The goal plan set is assigned to the worker because of worker's transfer.</td>
<td>Derived from the date on which the worker becomes eligible for the goal plan set after the worker’s transfer.</td>
</tr>
</tbody>
</table>
Scenario | Effective Dates of the Goal Plan Set for the Worker Is
---|---
A conflict might occur between the active dates of goal plan sets because of a worker’s transfer. You must manually change the effective dates of goal plan sets for the worker and resolve the conflict. Use the Administer Goals page in the Goals work area to change the dates. Depending on your role and security privileges, you can access the Administer Goals page.

The goal plan set is assigned to the worker because the worker is a new hire and is hired in the middle of the goal plan set duration. | Derived from the date on which the newly hired worker becomes eligible for the goal plan set. The effective start date of the goal plan set for the worker is later than the start date of the goal plan set.

---

**Changing Effective Dates of Goal Plan Sets: Examples**

Depending on your role and security privileges, you can change the dates of goal plan sets for a worker on the Administer Goals page in the Goals work area. These scenarios illustrate typical reasons for changing effective dates of the goal plan sets for a worker.

**Changing Effective Dates of a Goal Plan Set for a Worker**

Daniel Grayson, a worker in ABC Corporation, has the goal plan set assigned.

<table>
<thead>
<tr>
<th>Goal Plan Set</th>
<th>Start Date</th>
<th>End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>FY2015 Finance-UK</td>
<td>April 01, 2015</td>
<td>March 31, 2016</td>
</tr>
</tbody>
</table>

John Gorman, Daniel’s line manager, wants to extend the duration of the goal plan set for Daniel until December 31, 2016. Ellis Gibson is an HR specialist who has security privileges to manage goal plan sets. John sends directions to Ellis Gibson to change the effective end date of the goal plan set to December 31, 2016. Ellis uses the **Change Dates** option from the **Actions** menu on the Administer Goals page with **Worker Goal Plan Sets** selected to change the dates.

**Changing Effective Dates of Goal Plan Sets Because of a Worker’s Transfer**

Sonia Jalla, a worker from the US division of ABC Corporation, has the following goal plan set assigned to her.

<table>
<thead>
<tr>
<th>Goal Plan Set</th>
<th>Start Date</th>
<th>End Date</th>
</tr>
</thead>
</table>

She is scheduled to transfer to the UK division on October 9, 2015. The workers included in the UK division are automatically assigned the following goal plan set.
Post transfer, Sonia is eligible for the goal plan set FY2015 Annual-UK. The end date of the before transfer goal plan set, FY2015 Annual-US, and the start date of the post transfer goal plan set, FY2015 Annual-UK, conflict with each other. The application sets the status of the goal plan set FY2015 Annual-UK to pending and sends the notification about the date conflict to Ellis. Ellis uses the Change Dates option from the Actions menu on the Administer Goals page with Worker Goal Plan Sets selected. Ellis changes the start and end date of the goal plan set assignment to the desired dates and assigns both the goal plan sets with the updated effective dates.

<table>
<thead>
<tr>
<th>Goal Plan Set</th>
<th>Start Date</th>
<th>End Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>FY2015 Annual-UK</td>
<td>April 01, 2015</td>
<td>March 31, 2016</td>
</tr>
</tbody>
</table>

Resolving Conflict in Dates for Goal Plan Sets Due to Transfer: Explained

A conflict can occur between the dates of the goal plan sets because of a worker’s transfer.

When the conflict occurs, the dates of the existing goal plan sets remain same as they were defined. However, the goal plan set that is assigned to a worker post transfer is set to the pending status. The goals and goal plans included in the pending goal plan set are not assigned to the worker until the goal plan set status is set to active.

HR specialists can change the effective dates of the pending goal plan set for the worker and resolve the conflict.

With Worker Goal Plan Sets selected on the Administer Goals page, select the Change Dates option from the Actions menu to change the dates of goal plan sets.
11 Matrix Management

Using Matrix Management with Performance Goals: Explained

Matrix management functionality allows managers other than the worker’s line manager to view and track goals of workers. You enable matrix management in the Goal Management work area by using the Matrix Management Enabled for Goals profile option. You manage profile options in the Setup and Maintenance work area by using the Manage Worker Goal Setting Profile Option Values or Manage Administrator Profile Values tasks.

Matrix Managers

A matrix manager is a manager of a type other than line manager (for example, project manager, team manager, functional manager). You add manager types to workers using the Manage Employment task in the Person Management work area.

Tasks

Matrix managers can:

- Manage performance goals of dotted-line reports
- Add and assign performance goal for dotted-line reports
- Align performance goals of dotted-line reports to other goals
- Cancel performance goals for a dotted-line report, if those goals were assigned to the report by the matrix manager
- Delete performance goals for a dotted-line report, if those goals were assigned to the report by the matrix manager
- Update the person profiles of dotted-line reports by adding target outcomes to their performance goals

Notification and Access

When the worker completes a goal, matrix managers receive notification, if that notification option is enabled. You set up goal management notifications in the Setup and Maintenance work area.

The matrix manager accesses the report’s goals associated with a review period from the from the My Team Goals tab in the Goals work area. On the My Team Goals page, matrix managers can view dotted-line reports using the View option.

Related Topics

- Goal Management Profile Options
12 Scheduled Processes for Assigning Goals

Managing Scheduled Processes for Assigning Performance Goals: Procedure

The process of assigning performance goals using goal plan sets, goal plans, and mass assignment requests is an Enterprise Scheduler Service process. HR specialists submit and run the process on the Manage Goal Scheduled Process page in the Goals work area.

Managing Scheduled Processes

Follow these steps:

1. In the Goals work area, in the Related Links panel on the Tasks tab, click Manage Goal Scheduled Process. The Manage Goal Scheduled Process page appears.
2. Search for and select a process name.
3. Run the process as soon as possible or at a scheduled time.

Note: By default, the process runs as soon as possible if you submit the process without selecting a schedule.

4. Click Advanced and on the Scheduled tab, select Using a schedule to specify a date and time when you want the process to run. Or set up a recurring schedule for the process to run at the selected frequency.

After the process completes, the application assigns performance goals, goal plans, and goal plan sets as included in the request to all workers selected in the request.

Related Topics

- Goal Plans: Explained
- Goal Plan Sets: Explained
- Mass Assignment of Performance Goals: Explained

Scheduled Processes in Goal Management: Overview

As an HR specialist, you can schedule and run the processes in Goal Management to assign performance goals through goal plans, goal plan sets, or assign goals to multiple workers. In the Goals work area, Related Links panel, the Tasks tab, you can open the Manage Goal Scheduled Process page and run some of the processes.

<table>
<thead>
<tr>
<th>Process Name</th>
<th>Description</th>
<th>Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass Assign Goals</td>
<td>Assigns goals to multiple workers or creates goal plans for multiple workers at one go.</td>
<td>Process Name: You must select a name for mass assign goals that was created for worker assignment and goals.</td>
</tr>
<tr>
<td>Process Name</td>
<td>Description</td>
<td>Parameters</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assign Goal Plan</td>
<td>Assigns goal plan to the workers</td>
<td><strong>Process Name</strong>: When you select the goal plan to be processed, the start and end dates of the goal plan appear. You can specify <strong>Effective Date</strong> to include workers in the goal plan having a hire or start date same as or earlier than the specified effective date. If you don’t specify <strong>Effective Date</strong>, the application uses the current date as the effective date. For scheduled processes, the date when the process is run is used as the effective date every time the process runs.</td>
</tr>
<tr>
<td>Assign Goal Plan Set</td>
<td>Assigns goal plan set to the workers</td>
<td><strong>Process Name</strong>: When you select the goal plan set to be processed, the start and end dates of the goal plan set appear. You can specify <strong>Effective Date</strong> to include workers in the goal plan having a hire or start date same as or earlier than the specified effective date. If you don’t specify <strong>Effective Date</strong>, the application uses the current date as the effective date. For scheduled processes, the date when the process is run is used as the effective date every time the process runs.</td>
</tr>
<tr>
<td>Purge Goal Temporary Records</td>
<td>Deletes temporary records of goals assigned to employees as per the specified number of days.</td>
<td><strong>Purge Start Days</strong>: Indicates the number of days from the current day to remove the transient data in the application. By default, the number of days is set to 15. The transient data earlier to 15 days from the current date is removed by running this process. If you expect more data to purge, you can set <strong>Purge Start Days</strong> to a minimum of 3 days so that data prior to 3 days from the current date is purged. Depending on the frequency of running the Goal processes such as Mass Assign Goals, Assign Goal Plans, or Assign Goal Plan Sets, data gets accumulated in database storage and the application can become slow. You can schedule this process for the required duration to purge the data.</td>
</tr>
</tbody>
</table>

**Related Topics**

- Scheduled Processes: Explained
- Scheduled Process Options: Examples
- Scheduled Process Statuses: Explained
• Creating a Request for Mass Assignment of Performance Goals: Points to Consider
13 Eligibility Profiles for Assigning Goals

Using Eligibility Profiles for Performance Goals Assignment: Explained

An eligibility profile in Goal Management defines criteria used to determine whether an individual qualifies for a performance goal. HR specialists can use eligibility profiles to establish eligibility for performance goals when creating:

- A goal plan set for performance goal plans only
- A goal plan
- A mass assignment request for performance goals

Assignment of Goals According to Eligibility

If you select eligibility profiles in a goal plan set, goal plan, or in a mass assignment request for performance goals, the application assigns goals as follows:

- If all eligibility profiles are marked as required, then an individual must meet criteria of all the eligibility profiles.
- If no eligibility profile is marked as required, then an individual must meet criteria of at least one eligibility profile.
- If some eligibility profiles are marked as required and some are not, then an individual must meet criteria of all the required profiles and at least one nonrequired profile.
- If only one eligibility profile is marked as required, then an individual must meet criteria of that eligibility profile.

Restricting Goal Availability

You can restrict performance goals to individuals who meet eligibility requirements by job, job role, location, age, or other criteria. You must select eligibility profiles with profile usage marked as Goals Management. You can also select whether an eligibility profile is required for goals. For example, you can add the following eligibility profiles to a goal:

- Location is France
- Designation is Marketing Manager
- Designation is Product Manager

When mass assigning goals or creating and assigning a goal plan or goal plan set, you select Location is France as the required eligibility profile and leave the other two eligibility profiles as not required. In this case, the application assigns goals to all individuals whose location is France and designation is Marketing Manager or Product Manager.

Eligibility Profiles and Goal Plan Sets

Select eligibility profiles to restrict the goal plans added to a goal plan set to workers who meet the profile criteria. You can edit an existing goal plan set to add a new set of eligibility profiles to the goal plan set. The performance goals included in the goal plan are assigned to eligible workers. Eligibility profiles you add to a goal plan set supersedes any eligibility profiles added at the goal plan level.
Eligibility Profiles and Goal Plans
Select eligibility profiles to restrict the performance goals added to a goal plan to workers who meet the profile criteria. You can edit an existing goal plan to add a new set of eligibility profiles to goal plans.

Eligibility Profiles and Mass Assignment of Goals
Select eligibility profiles to restrict the performance goals during mass assignment of goals to individuals who meet the criteria of all required profiles and at least one nonrequired profile. You can edit an existing mass assignment request to add a new set of eligibility profiles.

Eligibility Profiles and Goals Accessibility
Use eligibility profiles when you mass assign performance goals or create and assign goal plans and goal plan sets to a target population. However, using eligibility profiles in these Goal Management processes doesn’t control a person’s accessibility to performance goals from other sources. You might assign a performance goal to a worker from the goal library or from other Oracle Fusion business processes, such as during a talent review meeting, or during a performance evaluation.

Related Topics
- Eligibility Profiles: Explained
- Goal Plans: Explained
- Goal Plan Sets: Explained
- Mass Assignment of Performance Goals: Explained

FAQs for Eligibility Profiles for Assigning Goals
Can I verify a person is eligible for assigning the goal plan or goal plan set?
Yes. Use the Check Person Eligibility button in the goal plan or goal plan set. In the Check Person Eligibility window, search for the person and then click Review. The application validates the person for the specified eligibility profiles. If multiple eligibility profiles exist, then you can get an overall eligibility of the person.

If the goal plan or goal plan set doesn’t have eligibility profile, the Check Person Eligibility button is dimmed.
Goal Integrations

Goal Management: How It Works with Profiles

The Goals work area uses predefined content types Licenses and Certifications, Competencies, and Languages as target outcomes. Target outcomes are content types that contain content items and maintained in the Profiles work area. Target outcomes help workers add or improve requisite skills, competencies, certifications, or other qualifications. Depending on content section access settings for your role, you can add target outcomes to performance goals.

After a worker completes a performance goal, the worker’s person profile is updated to include the content item that the target outcome addresses. If the content item exists in the worker’s person profile, the profile is updated to include new or changed information.

To use Licenses and Certifications, Competencies, or Languages content type as a target outcome in the Goals work area:

- The relevant subscriber code must be used to access the Profiles functional area from the Goals work area.
- The use of target outcomes must be enabled for the Goals work area. You enable target outcomes for the Goal work area by using profile options.
- Your role must have access to the content type. You set content section access settings for a job or abstract role by using the Manage Profile Content Section Access task in the Setup and Maintenance work area.
- The Goals content type must have a relationship with the content type. You add a relationship between the Goals content type and the corresponding content type in the Profiles work area.
The figure shows how the application adds the Customer Focus competency from the content library to a goal as a target outcome, and then to the worker profile when the goal completes.

Adding Target Outcomes to Performance Goals
If allowed, you can add target outcomes to goals when adding or editing performance goals for a worker. You can select target outcomes from the available list of content types competencies, languages, and licenses and certifications only. The content types available to you depend on the content section access settings for your role.

If allowed, you can also add target outcomes to performance goals when:

- Adding goals to the goal library
- Adding goals to a goal plan when creating or populating the plan
• Mass assigning goals
• Administering goals

Updating Worker Profiles

When the performance goal is completed, and approved if approvals are required, then the worker’s person profile is updated to include the target outcomes. For content items that require a rating level, such as competencies, the manager must select a rating level, which is the rating level associated with the content item. If approvals aren’t enabled for completing the percentage completion of a goal, the worker can also rate the competency associated with the goal. The evaluation type displayed for the competency is Self when the worker rates the competency.

**Note:** If you delete a goal, the ratings associated with a competency aren’t deleted from the worker’s profile. Depending upon the evaluation type, the user who rated the worker’s competency can delete or update the rating on the worker’s person profile even after the goal is deleted.

**Related Topics**

• How can I define a relationship between the Goals content type and other content types
• Content Types: Explained
• Content Items: Explained
• Goal Management Profile Options

Performance Documents: How They Work with Goals

During a performance evaluation, the line manager or worker can update a performance document to include performance goals and development goals. Workers and managers can create goals directly in the performance document. If Oracle Fusion Goal Management or Oracle Fusion Career Development are used, workers and managers can add goals from the goal library and the worker’s goals from those business processes. Workers and managers can maintain goals either in the performance document or using the goal management and career development business processes, and the goals are updated in the respective business process.

In the performance document:

• Performance goals are maintained in the Performance Goals section
• Development goals are maintained in the Development Goals section
The figure shows how performance documents integrate with the goal management and career development business processes, and how goals update the worker profile.

Manager Record Requirements
To use the performance management business process to manage performance documents, workers must have both a job and a line manager on their assignment record.

Adding Goals to the Performance Document
Depending on configuration, goals can be added to performance documents in these ways:

- The performance template can include performance and development goals that are added directly to the performance document.
• Workers and managers can add performance and development goals directly to a performance document.
• Workers and managers can import performance and development goals from the workers' other performance documents.
• Workers' performance goals from Goal Management populate the performance document.
• Workers' development goals from Career Development populate the performance document.

When created, the performance document may contain goals that the performance template is configured to provide. If Goal Management is used, the goals in the Performance Goals section may include the worker’s own performance goals and others selected from the goal library. If Career Development is used, the goals in the Development Goals section may include the worker’s own development goals or others added from the goal library. Only approved performance and development goals populate the performance document, if approvals are used in the goal management and career development business processes.

During the evaluation process the worker and manager can create goals, and add goals from the goal library, if it’s enabled. If they add a goal to the Performance Goals section, it becomes a performance goal. If they add a goal to the Development Goals section, it becomes a development goal. The worker and manager can also use the Import Goals and Competencies action to copy the worker’s goals (but not ratings or evaluation comments) from another of the worker’s performance documents. The Import Goals and Competencies action creates a new goal, but copies its key attributes from an existing goal in another performance document. The action is found on the pages used to evaluate the worker or set document content.

Performance and development goals created in a performance document aren't added to the goal library and aren't visible there. The performance goal can be viewed from the worker’s person spotlight and on all other pages where the goal is included except in the library. Development goals can be viewed only on the Career Development pages.

Updating Performance Documents from Goal Management

Performance and development goals that workers or managers add or edit in Goal Management, Career Development, or in performance documents are maintained such that they are consistent in their respective applications. For example, primary goal characteristics, such as the goal name, description, success criteria, and completion date, are kept identical in both locations. Any attachments to goals are also displayed in the performance document.

The goal details held in performance documents and the goal management or career development business processes have some differences:
• Goal ratings that the worker or manager provides in the performance document aren’t available on the Goal Management or Career Development pages.
• Performance goal weights added on the Goal Management pages are added to the performance document when the goal is initially added to the document. Afterward, the weights from Goal Management update in the performance document, if configured to do so, when the manager or worker uses the Update Goals and Competencies action in the performance document.
• Evaluation comments added to the performance document don’t show on the Goal Management or Career Development pages. However comments from the Goal Management and Career Development pages appear in the performance document.

Workers and managers can add performance goals on the Goal Management pages and the goals are pulled into the workers' performance documents when the documents are created. Goal plans are required to manage goals in Goal Management. The goals in a goal plan associated with the review period and document type selected for the performance document appear in the document when it’s created.

Development goals from Career Development populate the performance document when the dates of the development goal overlap any portion of the performance document dates. For example, a development goal with a start date before the performance document start date and either an end date after the performance document end date, or no end date, is pulled
into the performance document. Future development goals that start after the performance document concludes and those that are inactive can also populate the performance document, if configured to do so.

When managers or workers edit the worker’s existing goals in Goal Management or Career Development, the changes are reflected in the performance document when it’s opened. To copy new goals into the performance document from the goal management or career development business processes they must use the Update Goals and Competencies action in the performance document. Goals aren’t automatically removed from the performance document and must be manually removed.

### Updating Goal Management from Performance Documents

Updates made to the performance document are displayed in Goal Management and Career Development when the performance document is saved or submitted.

When a worker or manager adds a performance goal to the performance document, they can select the goal plan to which to add the goal. The selected goal plan must be one of those that were used to populate the performance document.

### Updating Profiles from a Completed Evaluation

When the performance document is completed the application updates the worker’s profile to include the goals section ratings for both the Performance Goals and Development Goals sections. Ratings for individual goals are maintained in the performance document only.

### Completing Goals in the Performance Document

When the performance document is completed the performance goals are updated in Goal Management and development goals are updated in Career Development. After that process concludes, managers and workers can’t update goals in the performance document either directly, or by using Goal Management or Career Development. They can continue to add or update goals in Goal Management or Career Development, but those changes aren’t reflected in the performance document.

### Setting Up the Performance Template to Use Goals

To manage goals in performance documents, implementors must:

- Create a Performance Goals performance template section to manage performance goals and add it to the performance template.
- Create a Development Goals performance template section to manage development goals and add it to the performance template.

To use Goal Management and the goal library with performance documents, they must also:

- Enable the Goal Management Business Process Enabled (HRG_USE_GOAL_MANAGEMENT) profile option using the Manage Administrator Profile Values task.
- Enable the Goal Library Enabled (HRG_ENABLE_GOAL_LIBRARY) profile option.
- Select the **Populate with worker goals** check box in the Performance Goals performance template section.
- Optionally, select the **Allow update goals action to update goal weights from goal management business process** check box in the Performance Goals performance template section.
- Select a review period and performance document type for the template associated with a goal plan for the performance template period.
To use Career Development and the goal library with performance documents, implementors must:

- Enable the Goal Library feature choice in the Workforce Development offering.
- Select the **Populate with workers development goals covering any part of evaluation period** check box in the Development Goals performance template section.
- Optionally select the **Include future development goals starting after evaluation period** and **Exclude inactive development goals** check boxes in the Development Goals performance template section.

**Related Topics**

- Setting Up the Performance Template: Critical Choices
- Removing Goals Contained in a Performance Document: Explained
- Performance Documents: How They Work with Profiles

## Social Networking with Performance Goals: Explained

If the page for editing a performance goal has a **Social** link, you can invite others to collaborate about the goal using social collaboration. Conversations remain with the goal as a historical record.

Examples of collaboration:

- A worker asks the manager to clarify objectives.
- The manager suggests actions for the worker to take toward goal achievement.
- A worker asks peers for advice on setting and achieving performance goals.

### Collaborating about Goals

**Tips for collaborating:**

- To get started, click **Social** on the page for editing a goal. Click the **Share** button, or click **Join** if collaboration is in progress.
- Click the name of the goal to access its wall, where you can start conversations and add members.
- After collaboration starts for a performance goal:
  - Anyone at your company can be invited to participate in a conversation about it.
  - A peer can only participate in conversations after being invited as a member.
  - The worker and the manager can initiate conversations and invite members.
- On the wall of the performance goal, everyone invited can view basic attributes of the goal and post documents and comments that all members can see.

**Related Topics**

- What does social networking have to do with my job
Glossary

aligned goals
Two goals that have a relationship with each other where one goal supports the other. It is not necessarily a parent-child
relationship although aligning a goal typically means aligning up to an organizational or manager goal.

best-fit analysis
A calculation of the best possible matches for a selected person or model profile.

competency
Any measurable behavior required by an organization, job, or position that a person may demonstrate in the work context. A
competency can be a piece of knowledge, a skill, an attitude, or an attribute.

content item
An individual quality, skill, or qualification within a content type that you track in profiles.

coloration
A repository of the content types and individual content items that can be associated with person profiles and profiles for
workforce structures such as jobs and positions.

content type
An attribute such as a skill, quality, or qualification that is added to a profile.

development goal
A goal that is geared toward facilitating the career growth of individuals so that they can perform better in their current job or
prepare themselves for advancement.

eligibility profile
A user-defined set of criteria used to determine whether a person qualifies for a benefits offering, variable rate or coverage,
compensation plan, checklist task, or other object for which eligibility must be established.

goal library
A central repository of reusable goals maintained by the human resource specialist that managers and workers can copy to
use for their own goals.

goal plan
A collection of performance goals that are grouped by common characteristics, such as a specified time frame or a particular
department that must work on them.
**goal plan set**
One or more performance goal plans that you assign as a group to a population set.

**HR**
Abbreviation for human resource.

**impact of loss**
A value assigned to a worker to rate the effect on the enterprise when the worker leaves.

**individual score**
The number assigned to each matching content item of the content types for which you specify the priority or importance.

**job**
A generic role that is independent of any single department or location. For example, the jobs Manager and Consultant can occur in many departments.

**job role**
A role, such as an accounts payable manager or application implementation consultant, that usually identifies and aggregates the duties or responsibilities that make up the job.

**model profile**
A collection of the work requirements and required skills and qualifications of a workforce structure, such as a job or position.

**organization goal**
A performance goal that specifies the overall objectives of the organization.

**organization owner**
Manager of an organization who adds and manages goals for the organization to support objectives and strategy of the enterprise.

**overall score**
The total of all individual scores of all matching content items in a best-fit analysis.

**performance document**
Online document used to evaluate a worker for a specific time period. The document contains the content on which the worker is evaluated, which could include goals, competencies, and questionnaires.
**performance goal**
A results-oriented goal, often using specific targets, to assess the level of a worker’s achievement.

**person profile**
A collection of skills, experience, qualifications, work preferences, and career planning information for a worker.

**position**
A specific occurrence of one job that is fixed within one department. It is also often restricted to one location. For example, the position Finance Manager is an instance of the job Manager in the Finance Department.

**profile type**
A template that defines the content sections of a profile, role access for each section, and whether the profile is for a person, or for a workforce structure such as a job or position.

**rating model**
A scale used to measure the performance and proficiency of workers.

**risk of loss**
A value assigned to a worker to rate the likelihood of the worker leaving the enterprise.

**sandbox**
A testing environment that isolates untested code changes from the mainline environment so that these changes don’t affect the mainline metadata or other sandboxes.

**source rating**
The rating level associated with a content item of the source profile in the best-fit analysis.

**talent review**
A series of meetings where organization managers evaluate trends, assess strengths, and address areas of risk for the organization.

**talent score**
An assessment of a worker's overall value to the enterprise using a company-defined rating model.

**target outcome**
A specific skill, competency, or certification added to a goal that can be achieved or acquired by the successful completion of the goal.
**target rating**
The rating level associated with a content item of the target profile in the best-fit analysis.

**task**
An action added to a goal that a worker plans to undertake to help achieve the goal.